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How to Use this Guide

This guide covers everything you need to know to begin using your new

Hewlett-Packard workstation. It provides step-by-step instructions for basic

tasks such as copying �les, printing documents, and starting applications.

Part I contains instructions for using the graphical user interface, HP VUE.

It explains everything you will need to know to be productive with your new

workstation. Part II is for more advanced users who prefer to work directly

with the HP-UX command line. This guide contains the following information:

Part I: Using HP VUE

Chapter 1, Getting Started explains how to turn on the power and log in for

the �rst time.

Chapter 2, Introducing HP VUE introduces the components of the HP VUE

interface.

Chapter 3, Learning Basic Skills helps you quickly learn to use windows,

menus, and other components of HP VUE.

Chapter 4, Getting Help explains how to get help in a hurry with HP Help, the

online help system.

Chapter 5, Working with Files describes how to manage �les and directories.

Chapter 6, Editing Files explains how to use the HP VUE Text Editor to edit

�les.

Chapter 7, Using Electronic Mail shows you how to send and receive

messages electronically.

Chapter 8, Using Multimedia explains the HP VUE multimedia applications

for audio and graphics.

Chapter 9, Using Applications explains the HP VUE toolboxes, which are

used to store applications.

Chapter 10, Printing explains how to print your work.

Chapter 11, Communicating over a Network describes how to use and

communicate with remote systems.

Chapter 12, Customizing Your System shows you how to customize your

workstation to your liking.
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Chapter 13, Doing Advanced Tasks provides pointers for more information
about advanced and system administration tasks not covered in this guide.

Part II: Using the HP-UX Command Line

Chapter 14, Getting Started with HP-UX Commands explains how to turn on

the power and log in for the �rst time with HP-UX commands.

Chapter 15, Working with Files and Directories shows you how to create,

view, print, and remove �les; create and remove directories; and navigate

between directories using HP-UX commands.

Chapter 16, Using Your Shell explains how to use command syntax, redirect

command input and output, and set your login environment.

Chapter 17, Using the vi Editor describes how to create and edit text using

the vi editor.

Chapter 18, Making Your System Secure covers system security and changing

�le and directory permissions with HP-UX commands.

Glossary explains common HP VUE and HP-UX terms.
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Typographic Conventions

This guide uses the following typographic conventions:

Boldface Words de�ned for the �rst time appear in boldface. For

example, windows are containers for applications.

Computer Computer font indicates literal items displayed by the

computer. For example:

file not found

User input Color indicates literal items that you type. For example:

cd

Italics Manual titles and emphasized words appear in italics, as do

values that you supply.

For example, in the command below you would

substitute an actual directory name (such as mydir) for
directory name.

cd directory name

�Enter� A rectangle with rounded corners and a label denotes a

keyboard key.

A notation like �CTRL�+�Q� indicates that you should hold

the control key down, then press �Q�.
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Getting Started

Your new workstation uses the HP Visual User Environment (HP VUE) and the

HP-UX operating system. HP VUE is a powerful graphical environment that

provides an interface to HP-UX.

HP VUE lets you take advantage of the versatility of HP-UX through simple

point and click operations with the mouse. It simpli�es many of your daily tasks

by giving you an easy way to start software applications, manage �les, and
use tools.

For a quick overview of HP VUE and its components, examine the HP VUE
Quick Start shipped with your system.

If you prefer to use HP-UX commands directly, see Part II of this guide, \Using

the HP-UX Command Line".

Part I: Using HP VUE Getting Started 1-1



Starting Your Workstation for the First Time

Your workstation should be installed and ready to use. If you have not yet

installed your workstation, please see the Hardware Installation Guide that
came with it.

Once your workstation is installed, this section explains how to start it for

the �rst time. It guides you through selecting the startup procedure, getting

required information, and turning on your computer.

If this is not the �rst time your workstation has been started, go to \Starting

Your Workstation After the First Time" later in this chapter.

Note Throughout this guide, you will see the term system
administrator. The system administrator is someone who

manages your system, taking care of such tasks as adding

peripheral devices, adding new users, and doing system backups.

In general, this person (who may also be called the system

operator or something similar) is the one to go to with questions

about implementing your software.

However, if you are the only user on a single-user workstation,

then whenever this guide refers you to the system

administrator, you should be able to get help from the system

administration manuals that you purchased with your system

(especially System Administration Tasks). Your HP support

engineer can also provide installation and maintenance help, in

accordance with your support contract.

Your workstation includes a tool called System Administration

Manager (SAM) that has complete online help to guide you

through system administration tasks. Use SAM only if a system

administrator is not available. To start SAM, log in as the

superuser and type /usr/sbin/sam, then press �Enter�. For
more information about SAM, see System Administration Tasks.

Chapter 13 lists advanced and system administration tasks, and

provides pointers for locating more information.

Choosing the Startup Procedure
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If your workstation has preloaded software (HP VUE and the HP-UX

operating system are loaded on the hard disk at the factory), the workstation

is shipped with a yellow sticker covering the power switch.

Follow the instructions in this section to start up a workstation with

preloaded software (also called \Instant Ignition").

If your workstation does not have preloaded software and you ordered the

HP-UX software separately, see your system administrator. Installing HP-UX
10.0 contains installation instructions.

If your system does not have a hard disk installed, or if it has a hard disk

installed but you want your workstation to be a client node in an HP-UX

cluster, see your system administrator. The System Administration Tasks
manual contains instructions for setting up clusters and client nodes.

Getting Required Information

Before you turn on your workstation, you should know the following

information. The workstation will request this information when you start

it for the �rst time, so that it can con�gure certain system and networking

parameters.

Note If you do not have some of this information now, such as the

host name or Internet address, you can add or modify it later.

Such modi�cations should be made as soon as possible after

initial installation. For instructions, see \Modifying System

Parameters".

The host name of your computer (sometimes called the system name). The

host name can be a simple name or an Internet fully-quali�ed name. Get the

host name from your system administrator.

Host name:

If you are connecting your computer to a local area network, you need to

know your computer's Internet Protocol address (IP or Internet address). This

is a four-part code (for example, 15.15.232.18) that uniquely identi�es your

computer among all those located on your network or any other network.

Obtain this address from your system administrator.

IP Address:
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The time zone where your computer is located (for example, Mountain

Daylight Savings Time). You don't need to know the standard abbreviation.

Time zone:

The root password. Be sure to write it down in a secure place. You will use

this password when you log in as superuser later in this chapter.

Note The root user, or superuser, is a special user. When logged in as

the superuser, you have the permission required to perform all

system administration tasks. Normally, the system administrator

is the only one who logs in as the superuser. The user name for

the superuser is root.

However, the very �rst time you (or anyone else) log into your

new workstation, you must do so as root because no other user
accounts have been created yet. Once accounts have been

created for other users, you should log out as superuser, then log

back in as one of those users.

Optional. You can con�gure additional network parameters such as the

subnetwork mask, the network gateway, and the Domain Name System name

server. Ask your system administrator if you should con�gure these parts of

the network.

Subnetwork mask: (Optional)

Network gateway host name: (Optional)

Network gateway IP address: (Optional)

Local domain name: (Optional)

DNS server host name: (Optional)

DNS server IP address: (Optional)

Network Information Service domain name: (Optional)

Optional. To save disk space, you may want your workstation to be a font
client. As a font client, your workstation uses the font �les on a network

server rather than using the fonts stored on its own hard disk, thus saving
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disk space. System RAM usage is reduced for font clients but increased for

font servers.

If you want your workstation to become a font client, ask your system

administrator for the name and IP address of the network font server. If you

do not choose to become a font client, all fonts will still be available from

your local disk.

Font server name: (Optional)

Font server IP address: (Optional)

For more information, see HP VUE's online help. Click the Help Manager

control (the books and question mark icon) on the Front Panel at the bottom

of your screen. Then click "HP Visual User Environment Version 3.0 Help",
then click \General Con�guration", then click \Network Font Server". Also

see the mk fnt clnt(1M) and mk fnt srvr(1M) manual reference pages.

Turning on the Power

1. Turn on the power switch on the monitor. The power LED lights to indicate

that the power is on.

2. Turn on the power to any external peripherals, such as printers, that are

connected to your workstation.

3. Turn on the power button on your workstation. The power LED lights to

indicate that the power is on.

4. As your workstation starts up, it runs a series of self-tests. For information

about these self-tests, see the troubleshooting chapter in your Owner's
Guide.

5. After two or three minutes, many messages appear on your screen. These

messages pertain to hardware and software subsystems that are being

activated, and you should not need to respond to any of the messages.

6. The �rst time you power up the workstation, a series of windows appear that

prompt you for the information about your workstation that you gathered in

the previous section, such as your host name, IP address, time zone, and root

password. Enter this information as it is requested.

If you do not set a host name now and instead accept the default host name

of unknown, you will get an error message when you log in.
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Note If you do not have the information when prompted for it, press

�Enter�. HP-UX then uses its default value for that question, and

you can add or modify the information later. Such modi�cations

should be made as soon as possible after initial installation. For

instructions, see \Modifying System Parameters".

7. When you have �nished answering the questions, the workstation completes

its startup sequence.

8. Once your workstation is running, it will display one of two ways to log in|
the HP VUE login screen or a command line prompt.

To log in, follow the instructions in \Getting Started with HP VUE". To

log in at the HP-UX command line, see \Logging In and Out of HP-UX" in

Chapter 14.

For help with using the mouse, see \Using a Mouse".

Desktop or Runtime HP-UX?

Your workstation may have been installed with a version of HP-UX called

\Desktop HP-UX." Your system administrator can tell you if you have Desktop

HP-UX or the standard Runtime HP-UX.

The Desktop version of HP-UX occupies less disk space than the Runtime

version because it does not install the full HP-UX functionality. Desktop

HP-UX contains most standard commands and networking, including Internet

Services, NFS, and core DCE. However, UUCP and SLIP are not included, nor

is functionality that is primarily intended for multi-user or server systems,

such as disk quotas, auditing, or system accounting. Desktop HP-UX also does

not contain routines for compiling C or graphics programs, the Key Shell (an

interactive HP-UX shell), online manual reference pages (man pages), or part of

the standard online help.

Your system administrator should be able to tell you which version of HP-UX

you have, and can install any additional functionality that you might need.
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Starting Your Workstation After the First Time

If this is the �rst time that your workstation has been started after it was

installed, go to \Starting Your Workstation for the First Time" earlier in this

chapter.

Otherwise, follow these steps:

1. Turn on the power switch on the monitor. The power LED lights to indicate

that the power is on.

2. Turn on the power to any external peripherals, such as printers, that are

connected to your workstation.

3. Turn on the power button on your workstation. The power LED lights to

indicate that the power is on.

4. As your workstation starts up, it runs a series of self-tests. For information

about these self-tests, see the troubleshooting chapter in your Owner's
Guide.

5. After two or three minutes, many messages appear on your screen. These

messages pertain to hardware and software subsystems that are being

activated, and you should not need to respond to any of the messages.

6. Once your workstation is running, it will display one of two ways to log in|

the HP VUE login screen or a command line prompt.

To log in, follow the instructions in \Getting Started with HP VUE". To

log in at the HP-UX command line, see \Logging In and Out of HP-UX" in

Chapter 14.

For help with using the mouse, see \Using a Mouse".

Part I: Using HP VUE Getting Started 1-7



Using a Mouse

This section explains how to navigate in HP VUE using the mouse. Instructions

for navigating with the keyboard are in Chapter 3.

For a right-handed mouse, the buttons are numbered as shown below. Your right

index �nger rests on button 1. To reverse the button mapping for left-handed

use, see \Changing Mouse Behavior" in Chapter 12.

Button numbering on two- and three-button mice.

As you move the mouse across your desk, a corresponding arrow moves across

the screen. This arrow is called the pointer.

You may notice these di�erent mouse and cursor shapes while using your
system:

Pointers (Mouse) Cursors
(Keyboard)

Working: Inserting:

Moving: Selecting:

Pointing:

Resizing:

Help:

Grabbing:
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Moving the pointer and dragging objects.

To move the pointer: To drag an object:

Move the mouse. 1. Move the pointer over the object.

2. Press and hold down the mouse button.

3. Move the mouse.

4. Release the mouse button.

You give HP VUE instructions by performing the following actions:

To click: Press and release a mouse button quickly (usually mouse button

1) without moving the mouse pointer.

To
double-click:

Press and release a mouse button twice quickly (usually mouse

button 1) without moving the mouse pointer. To change

the double-click speed, see \Changing Mouse Behavior" in

Chapter 12.

To select: Specify an object by moving the mouse pointer over the object

and clicking. No action is performed until you choose another

object, such as the OK button.

To choose: Perform a command or action by moving the mouse pointer over

an object and clicking.
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Selecting and choosing objects.
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Getting Started with HP VUE

This section explains how to log in, create user accounts (if necessary), and log

out using HP VUE.

Chapter 2 introduces the HP VUE environment, and Chapter 3 explains how to

use HP VUE.

Logging in with HP VUE

Logging in gives you a secure way to access your workstation. You log in by

typing a user name and a personal password. If your workstation is running

HP VUE, you will see the HP VUE login screen:

Log in using the HP VUE login screen.

If HP VUE has not been con�gured to start automatically, you see a login

prompt without windows when you start your system. To start HP VUE, see

\Enabling and Disabling HP VUE" in Chapter 12.

Note If you do not see the login screen, move the mouse slightly or

press �Shift� to activate the screen. Also check that the LED light

on the monitor is on. If not, turn on the power on the monitor.

If you still don't see the login screen, contact your system

administrator.

1. To run a standard HP VUE session, you do not need to select any login

options.
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To run HP VUE Lite, select the Options button, then choose \HP VUE Lite

Session" from the Options menu. (This is unnecessary if your previous

session was an HP VUE Lite session.) Your system may be con�gured to

automatically run an HP VUE Lite session. If this is the case, the HP VUE

session option in the Options menu is inactive.

To log in using a language other than English, select \Language" from the

Options menu. Also see \Using A Session in A Di�erent Language" in

Chapter 2.

Use the Options menu to select login options.

2. If you have a user account, type your user name in the Login box and press

�Enter�. You can backspace over any mistakes.

For example:

leslie �Enter�

If you don't have a user account yet, ask your system administrator to create

one, or follow the instructions in \Creating a New User Account" later in this

chapter. Until you get a user account, you may log in as superuser.

To log in as superuser, type the following in the Login box:

root �Enter�
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3. If you are logging in with your own user name, or if a password has been set

for root, you must enter the correct password in the Password box. Type

the password and press �Enter�.

You can backspace over any mistakes. The password does not appear on the

screen.

4. The copyright notice appears, followed by the HP VUE environment. You are

now logged in.

If you have logged in before, the Session Manager restores your most recent
session|your colors and mouse settings, and the window applications that

were running.

If you have not set a host name for your workstation, you will see an error

message telling you that your workstation does not have a unique name.

5. You'll see a workspace window (which occupies the entire screen), with a

Front Panel at the bottom of the screen. The Front Panel provides a central

location for controlling applications you use frequently. HP VUE has two

Front Panels, one for regular HP VUE sessions, and one for HP VUE Lite

sessions. HP VUE's Front Panel is described in Chapter 2.

The �rst time you log in, a Welcome window appears, as shown below. This

Welcome window introduces important features of your new workstation.

Spend a few minutes reading the contents of this window and learning about

your workstation.

To view this Welcome window again later, click the Help Manager control

(the books and question mark icon) on the Front Panel at the bottom of your

screen. Click the help topic titled \Welcome Messages".
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A typical HP VUE screen.

Creating a New User Account

User accounts allow users to log in to the system and use its resources. Only the

superuser can create new user accounts. If an account has been created for you

already, you do not need to create one. For additional security, you may also

require that a user enter a password during the login process.

To create new user accounts, use the system administration tool SAM (System

Administration Manager).

1. Log in as superuser (type root and press �Enter�, then type the password and

press �Enter�).

2. Click the small arrow above the Tools control on the HP VUE front panel.

The Tools subpanel appears.
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The Tools subpanel contains several toolboxes.

3. Click the icon for the General Toolbox. The General Toolbox opens.
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The General Toolbox contains many subdirectories for tools.

4. Double-click the System Admin subdirectory to open the system

administration tools.

5. Double-click the icon labeled SAM. You may have to scroll the window to

see this icon.

(The SAM icon can also be found in the Personal Toolbox.)

6. The SAM main window appears. Double-click the \Users and Groups" icon.

7. The \Users and Groups" window opens. Double-click the \Users" icon.

8. The \Users" window opens. Click the \Actions" menu.

9. A menu appears below the word \Actions". Click the \Add . . . " menu

selection.

10. The \Add a User Account" window opens. Click the box labeled \Login

Name:", then type the name for the new user account (the login name is
the same as the user name).

SAM provides defaults for the rest of the �elds in this screen. For

information about these �elds, click the Help button in the window.

11. Click the OK button.
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12. A password window opens. Click the box labeled \Password:", then type

the password for the new user account and click OK.

Note SAM allows you to set any character string as a password.

However, to improve system security you should follow these

guidelines:

A password must contain at least six characters. At least two

characters must be alphabetic, and one of those characters

must be a number or a special character (such as a dash (-), an

underline ( ), or an asterisk (*)). The password cannot contain

your user name, or even a reversed version of your user name

(for example, if your user name is dlm your password cannot

contain mld).

Examples of valid passwords are: wild-life, !secret, and
*fuzzy*.

Make sure you do not forget the password you use. If you forget

your password, contact your system administrator, or log in as

the superuser and set a new password with the SAM utility. To

change your password, see \Changing Your Password".

13. You are requested to re-enter the password. Click the box labeled

\Password:", then type the password exactly as you entered it the �rst time.

Click the OK button.

14. Click the File menu in the \Users and Groups" window, then click \Exit".

15. In the main SAM window, click the \Exit SAM" button. The SAM window

closes.

16. To close the General Toolbox, click its \File" menu, then click the \Exit"

menu selection.

17. Log out as root (see \Logging Out of HP VUE"), then log back in using your

regular user account.
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Logging Out of HP VUE

After you're done working for the day, or before you shut down your

workstation, you should log out. Logging out prevents other users from

accessing your workstation. However, it does not prevent others from accessing

your work over the network|to protect your work, see \File Ownership and

Security" in Chapter 5.

1. If you are using any applications, save your work, then exit the application.

2. Choose the logout control on the Front Panel.

Use the logout control to end the session.

Or, choose \Log out" from the Workspace Menu. To access the workspace

menu, move the pointer over the workspace backdrop and hold down mouse

button 3. A menu similar to that shown below appears.

The Workspace Menu also allows you to log out.

When you log out of a regular HP VUE session, Session Manager saves

information about your current session, like the number and position of

windows, so that it can be restored the next time you log in.
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Note If for some reason, the Front Panel and Workspace Menu are not

working properly, you can log out by canceling a session. No

session information is saved.

To cancel a session, simultaneously press �Shift� �Ctrl� �Reset�. If
you are using a PC-101 keyboard, press �Shift� �Ctrl� �Pause�. The
HP VUE login window appears after a short time.

Use this procedure to cancel a session only if the regular logout

procedure does not work.
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Shutting Down Your Workstation

Caution The shutdown procedure following this note applies only to HP

workstations with the Soft Powerdown feature. To determine if

your workstation has this feature, see your Owner's Guide.

Using this procedure with any other HP workstation may cause
data loss and/or damage to the hard disk drive. To shut down

any other HP workstation, follow these steps:

1. If you are using any applications, save your work, then exit

the application.

2. Click the up arrow above the Tools control on the HP VUE

front panel. A subpanel appears.

3. Click the General icon in the Tools subpanel. The General

Toolbox opens.

4. Double-click the \System Admin" subdirectory.

5. Double-click the \ShutdownSystem" action in the

\System Admin" subdirectory. You must have superuser

(root) permission to run this action.

You can leave your workstation running at all times without harm. However,

you may need to shut it down occasionally, to conserve energy or to attach

peripherals. You may turn o� just your monitor or the entire computer at the

end of each work day.

1. Ensure that your workstation has the Soft Powerdown feature (see your

Owner's Guide).

2. If you are using any applications, save your work, then exit the application.

3. Log out, using the procedure in \Logging Out of HP VUE".

4. Turn o� the power button on your workstation.

5. You will see this message:

Shutting down machine, please wait.

Your workstation then runs a program to shut itself down gracefully, without

data loss.

6. When the LED near the power button goes o�, the shutdown sequence is

�nished. You can safely turn o� the power switch on the monitor and any

peripherals.
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Changing Your Password

For password guidelines, see the note in \Creating a New User Account".

1. Display the Personal Toolbox by choosing the Tools control in the Front Panel.

Choose the Tools control to display the Personal Toolbox.

2. Double-click ChangePassword.

3. Type your current password and press �Enter�.

4. At the prompts, type your new password twice. The new password takes

e�ect immediately, so don't forget it!

5. To close the open toolbox window, choose \Exit" from the File menu.
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Modifying System Parameters

Use this section only if you need to add or modify the system parameter

information described in \Getting Required Information". Any modi�cations

should be made as soon as possible after initial installation.

Log in as the superuser and type the following command in a terminal window:

/sbin/set_parms option �Enter�

Where option is one of the following:

Option . . . Modi�es or sets . . .
hostname System host name

timezone Time zone

ip_address Internet Protocol address

addl_netwrk Additional network parameters (see page 1-7)

font_c-s Network font service (see page 1-7)

You can also set network parameters or network font service using the icons

labeled SetNetworking and FontClientSrvr, located in the General Toolbox

in the System Admin subdirectory (see \Creating a New User Account" for

instructions on opening the toolbox).

Any changes you make in set_parms will take e�ect after rebooting the system.

You can also use SAM to add or change most of this information.
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Information About Your Workstation

Manuals

To learn more about your workstation, HP VUE, and the HP-UX operating

system, continue reading this guide.

Within the United States, you can order any of the following manuals by calling

Hewlett-Packard at 1-800-227-8164. In other countries, contact your nearest

HP Sales and Support o�ce. For a complete list of HP-UX manuals and part

numbers, check the the manuals(1) manual reference page (see \Displaying a
Man Page" in Chapter 4).

These manuals are also available on CD-ROM with the optional HP-UX

LaserROM product. For information on LaserROM, contact your HP Sales and

Support o�ce.

System Installation

If you need help with system hardware installation, see the Hardware
Installation Guide for your system.

If you need help with peripheral installation, see the Owner's Guide for your
system.

If you have not yet installed your HP-UX system, see Installing HP-UX 10.0,
HP part number B2355-90050.

HP VUE Usage and Administration

For general HP VUE usage, read Part I of this guide.

If you want a quick overview of HP VUE, see the HP VUE Quick Start
shipped with your system.

For advanced HP VUE con�guration and system administration, see the HP
Visual User Environment 3.0 User's Guide, HP part number B1171-90079.

X Window System

See Using the X Window System, HP part number B1171-90076.

HP-UX Usage and Administration

For general usage of HP-UX, read Part II of this guide.
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For HP-UX system administration and troubleshooting information, see the

System Administration Tasks manual, HP part number B2355-90051.

For most system administration tasks, you can use the SAM tool (log in as

superuser by typing root, enter the superuser password, then type sam).
SAM contains an extensive online help system to help you perform system

administration tasks.

Online Help

If you are using HP VUE (or the X Window System), you can use the HP Help

System to access information about HP-UX and HP VUE.

To learn how to use HP Help, see Chapter 4.

The following subject areas in HP Help will be especially useful:

\Using Your HP Workstation", the online help corresponding to Part I of this

guide.

\HP Visual User Environment, Version 3.0", the online help corresponding to

the HP Visual User Environment 3.0 User's Guide.

\Common HP-UX Tasks" in "HP-UX Operating System Help", the online help
for HP-UX command line tasks.
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Where to Go Now

If you want to . . . Turn to . . .

Understand the HP VUE environment Chapter 2

Learn basic skills for window use Chapter 3

Learn about the online help system Chapter 4

Work with �les Chapter 5

Edit �les Chapter 6

Use electronic mail Chapter 7

Use multimedia Chapter 8

Work with applications Chapter 9

Print �les Chapter 10

Use remote workstations Chapter 11

Customize your workstation Chapter 12

Find pointers for advanced tasks Chapter 13

Find pointers for administration tasks Chapter 13

Use HP-UX commands Part II
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Introducing HP VUE

HP VUE is a graphical user interface that provides workspaces, windows,

menus, controls, and a Front Panel to help you organize and manage your

software applications.

A workspace is the screen area where you bring the applications needed for

your work. There are six workspaces in HP VUE and four in HP VUE Lite.

A window contains a software application and frames it with controls so you

can move it, make it larger or smaller, or put it in additional workspaces.

The Front Panel is a window that contains a collection of frequently-used

controls and services all your workspaces. It is positioned at the bottom of the

screen by default. A complete description of the Front Panel is found later in

this chapter.

Menus and controls help you manage and operate the software application.
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Overview of HP VUE

HP VUE creates an environment for interacting with your workstation. This

environment is called a \visual" or \graphical" environment because it provides

a display to guide you through performing tasks. HP VUE also includes a set of

applications, such as a text editor and a style manager, that make it easier to use

and customize your workstation.

This illustration shows HP VUE with several windows and applications running.

Chapter 1 explains how to start your workstation and log in.

d a

c b

HP VUE has many built-in applications.

Computers understand commands, and commands often have complex rules and

syntax. If you are not running HP VUE, you must learn these commands and

then type them in exactly the right way to accomplish a task.

With HP VUE, you can give commands to your computer without having to

learn or type commands.

In HP VUE, commands are represented by icons (called controls) drawn on

the Front Panel of the display. These controls look much like buttons on an

instrument panel. You use the mouse or keyboard to \push" the buttons.
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For example, you can use the Mailer control, shown below, to start an electronic

mail program.

The Mailer control starts an electronic mailer.

While HP VUE provides an easy way to work with �les and applications using

icons, some tasks may require you to type HP-UX commands using a command

line. You can use an HP VUE terminal window for typing commands.

If HP VUE is not running, the command line is still available. See Part II of this

guide for information on common HP-UX commands, and \Overview of the

Non-Windowed Environment" later in this chapter.

Features of HP VUE

HP VUE includes these features:

Windows are containers on the screen for applications; they let you run more

than one application at a time.

Workspaces allow you to have the equivalent of up to six di�erent screens,

although only one screen is displayed at a time. It's as though your display

had several layers that you can shu�e.

Workspaces provide a way to organize your work. Each workspace can

contain its own set of windows. For example, in one workspace you can run

windows containing word-processing and desktop publishing applications,

while in another workspace you can run windows containing spreadsheet and

chart programs.

Icon-based �le management. Files are represented by icons that can be

selected and moved.

Front Panel controls and toolboxes for easy access to applications.

Extensive online help, provided by the HP Help Manager.

Session management. HP VUE remembers which applications were running

when you logged out and restarts them the next time you log in.

Easy customization for colors, fonts, window behavior, and other aspects of

the appearance and behavior of your workstation's interface.
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Easy-to-use Text Editor and Icon Editor.

Multimedia (text and audio) application for annotating �les.

Multimedia (images and audio) applications for playing, recording, and editing

audio; and capturing and viewing images.

HP VUE|Regular and Lite

Regular HP VUE sessions provide all the functionality of HP VUE. Regular HP

VUE is most likely the default interface on your workstation.

However, some models and con�gurations of HP workstations may not provide

satisfactory performance when running HP VUE.

HP VUE Lite is a subset of HP VUE that provides enhanced performance

in exchange for some features. VUE Lite improves system performance by

omitting the following:

File Manager, File Annotator, Toolboxes

Session Manager

Printer and trash controls

To use HP VUE Lite, select it from the Options menu on the HP VUE login

screen.

Choosing the HP VUE Environment

HP recommends that you use HP VUE (or HP VUE Lite) on your workstation

whenever possible. The features of HP VUE make it easier to learn about and

use your workstation. Use HP VUE (or HP VUE Lite) if you:

Want an easy-to-use interface. You'll still be able to type commands in a

window if you choose.

Want to run more than one application at a time. You can run applications

that create their own windows and applications that run in a terminal

window.

Want to run the applications that are part of HP VUE. For example, HP VUE's

Text Editor provides an easy way to edit �les. Its Help Manager lets you

access extensive online information.

If HP VUE has not been con�gured to start automatically, you see a login

prompt without windows when you start your system. To start HP VUE, see

\Enabling and Disabling HP VUE" in Chapter 12.
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Overview of the Non-Windowed Environment

When HP VUE is not running, you have a command line interface for running

HP-UX commands, using special applications, and performing certain system

administration tasks. For more information on commands, see Part II of this

guide.

For example, to view the �les in a directory, type the ls command and press

�Enter�.

The ls command lists �les.

Use a non-windowed environment if you want to run a single application that

uses the entire display, such as a CAD application.

To temporarily suspend HP VUE to work at the command line, see \Suspending

HP VUE Using No Windows Mode". To totally disable HP VUE, see \Stopping

HP VUE" in Chapter 12.
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Summary of Features

Feature HP VUE HP VUE
Lite

Non-
Window

Windows yes yes no

Workspaces yes yes no

File management using icons yes no no

Front Panel containing

controls for common tasks

yes yes no

Toolboxes containing

applications

yes no no

Text editor HP VUE Text

Editor or other

editors

other

editors

Icon editor yes yes no

Session management yes partial no

Applications for customizing

your workstation

yes yes no

Command line yes yes yes

Mailer yes yes yes
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HP VUE Regular Session Front Panel

By default, the Front Panel for a regular HP VUE session appears as a long

rectangle across the bottom of the display. For clarity, we'll describe the panel

in three parts: left side, center, and right side.

Front Panel Left Side

Front Panel Left Side

Clock displays the current workstation time.

Date displays the current workstation date.

Load displays workstation activity.

Style
Manager

starts Style Manager with which you change display

appearance, such as color, and change system device behavior,

such as mouse double-click speed.

Help Manager starts Help Manager.

Logo gives HP VUE version information.

Lock locks your workstation, preventing unauthorized input.

Rename
Workspace

displays a dialog in which you can rename a workspace.

Terminal
Window

starts a terminal window, providing access to a command line

prompt.

Text Editor starts Text Editor.
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Front Panel Center

Front Panel Center

Audio Control displays the Audio Control Panel, which lets you select audio

volume, input, and output. The control is also a drop zone that

accepts an audio �le icon.

Workspace
Controls

used to select another workspace.

Front Panel Right Side

Front Panel Right Side

Printer displays printer job status on the system default printer.

Mailer starts your electronic mail application.

File Manager starts a File Manager window showing your home directory.

Tools opens your Personal Toolbox.

Trash Can displays the contents of the trash can.

Logout begins the logout process.
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Progress
Light

blinks to indicate an activity in progress, such as a new window

opening.
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HP VUE Lite Session Front Panel

By default, the Front Panel for an HP VUE Lite session also appears as a long

rectangle across the bottom of the display. There are some di�erences between

this Front Panel and the regular HP VUE Front Panel. For clarity, we'll describe

the HP VUE Lite Front Panel in three parts: left side, center, and right side.

HP VUE Lite Front Panel Left Side

HP VUE Lite Front Panel Left Side

Clock displays the current workstation time.

Date displays the current workstation date.

Style
Manager

starts Style Manager with which you change display

appearance, such as colors, and change window behavior.

Help Manager starts Help Manager.

Logo gives HP VUE version information.

Lock locks your workstation, preventing unauthorized input.

Rename
Workspace

displays a dialog in which you can rename a workspace.

Text Editor starts Text Editor.
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HP VUE Lite Front Panel Center

HP VUE Lite Front Panel Center

Workspace
Controls

used to select another workspace.

HP VUE Lite Front Panel Right Side

HP VUE Lite Front Panel Right Side

Mailer starts your electronic mail application.

Tools can be con�gured to run an application of your choice.

Terminal
Window

starts a terminal window, providing access to a command line

prompt.

Logout begins the logout process.

Progress
Light

blinks to indicate an activity in progress, such as a new window

opening.
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Introducing the Front Panel

You use the Front Panel to activate HP VUE applications or change to a

di�erent workspace. To do so, you move the pointer to the control that

represents the action you want, and click mouse button 1.

Some controls have an arrow above them. When you click the arrow, a

subpanel pops up. This subpanel extends the control's functionality.

Use the arrow controls to display and close the subpanels.

To get help on a control, choose On Item in the Help subpanel. The pointer

changes to a question mark. Move the pointer over the control or application

you need help with, and click mouse button 1. This feature only works with

Workspace Manager dialogs, Front Panel controls, or subpanel controls.

Chapter 3 provides more detail on using the Front Panel and other HP VUE

features.
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Starting Optional Types of HP VUE Sessions

In addition to the regular HP VUE session, HP VUE provides these other types

of sessions:

HP VUE Lite is a scaled-down version of HP VUE. It is useful for

limited-memory systems, or in situations where you do not need all the

functionality of regular HP VUE. Starting an HP VUE Lite session is described

in \Logging in with HP VUE" in Chapter 1.

A session in a di�erent language lets you use HP VUE in a language other

than English.

A failsafe session provides a terminal window. It is useful for performing

con�guration tasks before logging into another HP VUE session.

No Windows mode lets you temporarily leave HP VUE to work outside the HP

VUE environment.

HP VUE provides optional session types.
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Using A Session in A Di�erent Language

The default language for your system is set by your system administrator. The

Options menu lets you access other languages. Choosing a language in the

Options menu sets the LANG environment variable for your session. The default

language is restored at the end of the session.

1. Select the language using the menu displayed from Language in the Options

menu on the Login Screen.

2. Type your user name and password when prompted to do so. See \Logging

in with HP VUE" in Chapter 1 for more information.

Logging Into and Out of a Failsafe Session

A failsafe session is a simple session that starts the Workspace Manager and a

single terminal window. It provides a way to correct improper HP VUE sessions

caused by errors in the login and session con�guration �les. As such, it is

probably something that you will seldom use.

Logging In

1. Select \Failsafe" from the Options menu.

2. Type your user name and password when prompted to do so. See \Logging

in with HP VUE" in Chapter 1 for more information on logging in.

Logging Out

Type exit in the terminal window and press �Enter�.

Suspending HP VUE Using No Windows Mode

No Windows mode is not an HP VUE session. When your system is in No

Windows mode, HP VUE is suspended, and you must type all commands. You

log in from the operating system login prompt, rather than HP VUE's Login
Manager.

Note Certain types of con�gurations do not provide a No Windows

mode option.
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Entering No Windows Mode

1. Choose \No Windows" from the Options menu. The login screen disappears

and is replaced by an operating system prompt, typically a $ or a >.

2. Type your user name and password when prompted to do so. See \Logging

In and Out of HP-UX" in Chapter 14 for more information on logging in at

the command line.

Leaving No Windows Mode

Type exit at the prompt, and press �Enter�.
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Using a Home Session

Ordinarily, HP VUE saves session information when you log out and uses that

information to start your next session. If you start or stop applications during

your session, or use Style Manager to change the appearance and behavior of

your system, changes you make are re
ected in your next session. This type of

session is called a current session.

HP VUE also provides a home session. A home session is a session that you

explicitly save. It's like taking a snapshot of your current session at some point

in time. Once you have saved a home session, you can specify that logging in

always restores that session instead of the current session.

Saving a Home Session

1. Choose the Style Manager control in the Front Panel. The Style Manager

appears.

2. Choose the Startup button in Style Manager to display the Startup dialog.

Style Manager lets you save your home session.

3. Choose Set Home Session in the Startup dialog.
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Choose \Set Home Session . . . " to save the current state of your session.

4. A warning dialog box appears, informing you that this action will replace

your home session with the current session. Choose OK.

Automatically Starting the Home Session at Login

1. Choose the Style Manager control in the Front Panel.

2. Choose the Startup control in Style Manager to display the Startup dialog.

3. Select \Return to Home session."

4. Choose OK.

When you choose \Return to Home session," Session Manager will not save your
session at logout.

Choosing Between Current and Home Session

1. Choose the Style Manager control in the Front Panel.

2. Choose the Startup button in Style Manager to display the Startup dialog.

3. Select \Ask me at Logout."

4. Choose OK.
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You decide what will be your next session|current or home|at logout time. If

you choose \Return to Home session," the current information is not saved.

(You cannot change your mind the next time you log in.)

If you choose \Resume Current Session" and you have opened a large number of

of terminal windows, HP VUE will try to start them all the next time you log in,

which could take several minutes.

2-18 Introducing HP VUE Part I: Using HP VUE



Using the Display Lock and Timeout

The display lock lets you prevent other people from using your workstation

when you are away from it without logging out.

System timeout automatically turns o� the display after a speci�ed amount

of time elapses in which you haven't used the keyboard or mouse. Timeout

prevents the colors on the screen from \burning" the picture tube.

Locking and Unlocking the Display

To lock the display, choose the lock control in the Front Panel.

Choose the lock control to lock your display.

To unlock the display, type your password and press �Enter�.

Customizing Display Lock and Timeout

You can change the following settings:

The appearance of the locked display.

The amount of time until timeout.

Whether or not to lock the display at timeout.

To change these settings, use Style Manager's Screen control. For detailed

instructions, see \Changing Screen Settings" in Chapter 12.
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3

Learning Basic Skills

HP VUE provides windows, menus, and workspaces to help you organize your

work and perform daily tasks. To use HP VUE easily and e�ciently and take

advantage of its powerful features, you will need some basic skills.
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Using Windows

The basic object in an HP VUE workspace is a window. There are a number of

controls on the window frame that allow you to manipulate and position each

window.

You can use the mouse or the keyboard to move around windows and
workspaces. Basic mouse use is described in \Using a Mouse" in Chapter 1. If

you use the keyboard, note the following:

�Alt� is the same as �Extend char� on some keyboards.

�Enter� is the same as �Return� on some keyboards.

The Window Frame

Each application in HP VUE is contained within a window. The window has

controls that perform these functions:

Focus the workstation's attention on the application window. When a

window becomes \active," its frame changes color and the application can

receive information from you via the keyboard. The active window is said

to \have the focus." A window becomes active when one of the following

conditions occurs:

Whenever you move the mouse pointer into a window and click mouse

button 1, if the HP VUE Window Manager resource keyboardFocusPolicy
is set to explicit. This is the default setting.

Automatically whenever you move the mouse pointer into the window, if

the HP VUE window manager resource keyboardFocusPolicy is set to

pointer. See Chapter 12 for information on changing resource values.

Move the window to a convenient location on the screen or to another

workspace.

Make the window bigger or smaller, or iconify it.

Remove the window from the workspace.
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The window frame provides several controls.

Window menu button Accesses the window menu.

Title bar Shows the title of the window.

Minimize button Iconi�es the window.

Maximize button Enlarges the window to �ll the entire screen.

Side resize Resizes the window horizontally or vertically.

Corner resize Resizes the window both horizontally and vertically.

Opening and Closing an Application Window

Opening an Application Window

Choose the application's control in the Front Panel.

Or, choose its icon in a toolbox. Toolboxes are discussed in Chapter 9.

Or, execute the command from a terminal window to start the application.

Part I: Using HP VUE Learning Basic Skills 3-3



Closing an Application Window

Note Save your work before closing an application.

With the mouse, choose \File" in the application's menu bar at the top of

the window, then choose \Exit" or \Close". If there is no \File" choice, then

double-click the window menu button.

With the keyboard, press �Alt�+�F4�.

Closing an application removes it from all workspaces.

Turning a Window into an Icon

As you work, your screen can become cluttered with windows. Changing a few

of those windows into window icons tidies up the workspace. A window icon is

a miniature representation of the application window. Applications represented

by window icons continue to run.

Mouse

Click the window's Minimize button.

Use the Minimize button to iconify a window.

Keyboard

1. Press �Alt�+space bar to display the window menu.

2. Choose the command:

Press the down arrow until you reach the command, then press �Enter�.
Or, press �N�, the mnemonic shortcut.
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Restoring an Iconi�ed Window

Mouse

Double-click the icon.

Or, click mouse button 3 with the mouse pointer over the icon, and choose

\Restore" from the window icon menu.

Keyboard

1. Press �Alt�+space bar (hold down �Alt� while pressing the space bar) to display

the window menu.

2. Choose the command:

Press the down arrow until you reach the command \Restore," then press

�Enter�.
Or, press �R�, the mnemonic shortcut.

Moving a Window or Window Icon

Mouse

1. Position the pointer:

For a window, move the pointer over its title bar.
For a window icon, move the pointer over the icon.

2. Hold down mouse button 1 and drag the icon to its new location.

Move a window by dragging it by its title bar.

Keyboard

1. Press �Alt�+space bar to display the window menu.

2. Press �M�, the mnemonic shortcut for the \Move" command.

3. Use the arrow keys to relocate it.

Note To move the window faster, press and hold �CTRL�, then press

the arrow key.

4. Press �Enter�. To cancel the move, press �Esc�.
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Resizing a Window

You can change the size of the window using the frame components.

Note If you resize a terminal window containing an application, the

application may not know about the resizing and act as if the

window were the original size. After resizing a terminal window

with one of the procedures described below, exit the application

and type the following at the command line prompt:

eval `resize` �Enter�

Mouse

1. Place the pointer on a window frame's side or corner.

Use the window frame to resize a window.

2. Hold down mouse button 1 as you drag the window outline to the new size.

You can use any of the sides or corners to resize a window. The top and

bottom resize the window vertically, the left and right sides resize the window

horizontally, and the corners resize in both directions.

Keyboard

1. Press �Alt�+space bar to display the window menu.

2. Press �S�, the mnemonic shortcut for the \Size" command.

3. Use the arrow keys to stretch or shrink the window.
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4. Press �Enter�. To cancel the resizing, press �Esc�.

Note To resize a window faster, press and hold �CTRL�, and then press

and hold the arrow key.

Changing the Order of Overlapping Windows

Windows in a workspace can overlap, just like pieces of paper on a desk. And,

like papers, you can change the stacking order, bringing the one needing your

attention to the top.

Mouse

To bring a window to the top, click a visible part of the window's frame.

To bring a concealed window to the top, choose \Shu�e Up" from the

Workspace menu.

To access the workspace menu, move the pointer over the workspace

backdrop and press and hold mouse button 3. For more information, see \The

Workspace Menu".

Keyboard

To cycle through the windows, press �Alt�+�Tab�.

To bring the bottom window to the top, press �Alt�+�ESC�.

To put the top window on the bottom, press �Alt�+�Shift�+�ESC�.

Putting a Window in Other Workspaces

You can organize application windows by choosing which applications belong in

each workspace. For example, a workspace could contain applications used for

correspondence, such as a mailer and Text Editor. Or, you could choose to set

up your workspaces according to projects.

A window can occupy one or more workspaces. The workspaces that a window

currently occupies are highlighted in the Occupy Workspace dialog.

Mouse
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1. To put a window in all workspaces, click the window menu button (the one

in the upper left corner of the window frame), and choose \Occupy All

Workspaces".

2. To put the window in the workspaces you select, choose \Occupy Workspace"

from the window menu. The Occupy Workspace dialog appears.

Use the Occupy Workspace dialog to select workspaces.

3. Click to select or unselect the workspace(s) for the window to occupy.

Selected names are highlighted, and you can select any or all of the

workspaces listed.

4. Choose OK.

Keyboard

1. Press �Alt�+space bar to display the window menu.

2. To put the window in all workspaces, press the down arrow key until you

reach \Occupy All Workspaces", then press �Enter�.

3. To put the window in selected workspaces, choose \Occupy Workspace", then

press �Enter� to open a dialog.

4. Tab to the Workspaces list.

5. Select the workspace(s) for the window to occupy:

Use the arrow keys to move through the list.
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Press the space bar to select or unselect a workspace. Selected names are

highlighted.

6. Tab to OK, and press �Enter�.

Navigating with the Keyboard

Within a Workspace

Key(s) Moves to . . .

�Alt�+�Tab� Next window or window icon.

�Shift�+�Alt�+�Tab� Previous window or window icon.

�Alt�+�F6� Next window belonging to an application or between the

Front Panel and a subpanel.

�Shift�+�Alt�+�F6� Previous window belonging to an application or between

the Front Panel and a subpanel.

Within a Window

�Tab� Next tab group.

�Shift�+�Tab� Previous tab group.

�	� Next control in a tab group.

��� Previous control in a tab group.

Within a Menu

�	� Next menu command.

��� Previous menu command.
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Using Menus

A menu is a list of frequently-used commands that help you manage windows

and operate software applications.

Choosing a menu command performs an associated action. For example,
choosing \Minimize" from a window menu turns the window into an icon. Some

of the most common menus are:

Window menus.

Window Menu

The Workspace menu.

Workspace Menu

Software application menus:
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Menus that \pull down" from the application's menu bar.

Application Pulldown Menu

Menus that \pop up" on an application or on a desktop object.

Application Popup Menu

Menu commands whose labels are \greyed out" are inactive. These commands

are only available under certain conditions. For example, the \Restore"

command is available in a window menu only when the window is an icon.
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An underlined character in a command is called a mnemonic. A key sequence

listed to the right of some commands is called an accelerator. Both mnemonics

and accelerators provide you with quick keyboard access to menu commands.

For example, the \Close" command on the window menu can be accessed by

pressing the �c� key (the mnemonic), or by pressing �Alt��f4� (the accelerator).

The Window Menu

The window menu provides easy access to services that control the behavior of

the window.

Window and Window Icon Menus

Restore Turns an icon back into a window. This item

is active only when the window is an icon or

maximized.

Size Interactively changes the size of the window. This

item is inactive in the icon's menu.

Minimize Turns the window into an icon.

Maximize Enlarges the window to its greatest allowable size.

Lower Puts the window on the bottom of the stack of

overlapping windows in a workspace.

3-12 Learning Basic Skills Part I: Using HP VUE



Occupy Workspace Displays a dialog to select the workspaces in which

the window should appear.

Occupy All Workspaces Displays the window in all workspaces.

Unoccupy Workspace Removes the window from the current workspace.

This item is inactive if the window is displayed in

only one workspace.

Close Closes the window, removing it from the workspace.

Choosing a Command from a Window Menu

Mouse

1. Click mouse button 1 on the window menu button to display the menu.

Or, if the window is an icon, click the icon.

2. Click a menu command.

Or, you can use the dragging method:

1. Hold down mouse button 1 as you drag the pointer through the menu.

2. When you reach the command, release the mouse button.

To close the menu without choosing a command, click anywhere o� the menu,

or press �Esc�.

Keyboard

1. Press �Alt�+�Tab� until you reach the window or window icon.

2. Press �Alt�+space bar to display the window menu.

3. Press the command's mnemonic, the underlined character.

To close the menu without choosing a command, press �ESC�.

The Workspace Menu

The Workspace menu contains commands that help manage the workspace.
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Workspace Menu

Shu�e Up Puts the bottom window (in a stack of overlapping

windows) on the top of the stack.

Shu�e Down Puts the top window (in a stack of overlapping

windows) on the bottom of the stack.

Refresh \Repaints" the screen should the display become

unreadable.

Minimize/Restore Front

Panel

Turns the Front Panel into an icon. When selected a

second time, restores the Front Panel.

Restart Workspace

Manager

Stops, then restarts the Workspace Manager after
you have customized con�guration �les.

Log out Begins the logout process, the same as choosing the

exit button in the Front Panel.

1. Move the pointer over the workspace backdrop.

2. Press and hold mouse button 3. The Workspace menu appears.

3. Drag the pointer through the menu while still holding down button 3.

4. When you reach your choice, release button 3.

Note The Workspace menu can only be accessed with the mouse.
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Using the Front Panel

The Front Panel provides a central location for controlling applications you use

frequently. See Chapter 2 for a complete description of the Front Panel.

Choosing a Front Panel Control

Mouse

Move the pointer over the control and click mouse button 1.

For example, to bring up your Personal Toolbox, move the pointer into the

Tools control and click mouse button 1.

Use the Tools control to open your Personal Toolbox.

Keyboard

1. Press �Alt�+�Tab� until you reach the Front Panel.

2. Move keyboard highlight to the control:

�Tab� moves the highlight to another row.

The arrow keys move the highlight to a control within a row.

3. Press �Enter� to choose the control.

Choosing a Control on a Subpanel

Mouse

1. On the Front Panel, move the pointer over the up arrow above the control

and click mouse button 1 to display the subpanel.

2. Move the pointer over the desired subpanel control and click mouse button 1.

For example, to bring up the General Toolbox:
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1. Move the pointer to the arrow above the Tools control and click mouse

button 1. The Tools subpanel appears.

2. Move the pointer to the General icon (a large toolbox) in the subpanel and

click mouse button 1. The General Toolbox dialog box appears.

Use the Tools Subpanel to open the General Toolbox.

Keyboard

1. Move keyboard input focus to the Front Panel control's up arrow. In other

words, make the Front Panel control's up arrow active.

2. Press �Enter� to display the subpanel.

3. Move keyboard input focus to the subpanel control:

�Alt�+�F6� moves focus between a subpanel and the Front Panel.

The arrow keys move focus within a subpanel.

4. Press �Enter� to choose the control.
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Closing a Subpanel

Choose the down arrow at the bottom of the subpanel.

Use the down arrow control to close a subpanel.

Moving a Subpanel

Move a subpanel as you would move any other window.

Moving the Front Panel

Mouse

1. Move the pointer over the Front Panel.

2. Hold down �Alt�+mouse button 1.

3. Drag the Front Panel to its new location.

4. Release �Alt� and mouse button 1.

Keyboard

1. Press �Alt�+�Tab� until you reach the Front Panel.

2. Press �Alt�+space bar to display the Front Panel menu.

3. Press �M�, the mnemonic shortcut.
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4. Use the arrow keys to relocate the Front Panel.

5. Press �Enter�.

Turning the Front Panel into an Icon

You can iconify the Front Panel to save space on the screen.

Mouse

1. Move the pointer over the workspace backdrop and click mouse button 3.

The workspace menu appears.

2. Choose \Minimize/Restore Front Panel" from the Workspace menu.

Note If you don't see \Minimize/Restore Front Panel" in the

Workspace Menu, use the keyboard procedure below or see your

system administrator.

Keyboard

1. Press �Alt�+�Tab� until you reach the Front Panel.

2. Press �Alt�+space bar to display the menu.

3. Press �N�, the mnemonic shortcut.

Restoring the Front Panel

Double-click its icon.

Or, choose \Minimize/Restore Front Panel" from the Workspace menu.

Or, move the pointer into the Front Panel icon, click mouse button 3, and

choose \Restore" from the icon menu.

Displaying Another Workspace

Mouse

Click the workspace's control in the Front Panel.
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Use the Workspace controls to switch workspaces.

Keyboard

1. Press �Alt�+�Tab� until you reach the Front Panel.

2. Tab to the top row.

3. Use the arrow keys until you reach the button for the workspace you want

to display.

4. Press �Enter�.

Renaming a Workspace

You may want to change the names of the various workspaces from time to

time, as you complete one project and begin another.

Mouse

1. Switch to the workspace you want to rename. Use the Workspace controls in

the middle of the Front Panel.

2. Choose the Rename Workspace control in the Front Panel to open the

Rename Workspace dialog.

Use the Rename Workspace control to give workspaces new names.
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3. Move the pointer into the Rename Workspace dialog. A blinking \I-beam"

cursor appears after the last character of the current workspace name. Press

the �Backspace� key until the current workspace name is deleted, then enter

the new name.

4. Choose OK.

Note Instead of backspacing to delete the current workspace name,

you can double-click mouse button 1 to highlight the current

workspace name, and then just enter the new name. If the

current workspace name is more than one word, triple-click

mouse button 1.

Keyboard

1. Switch to the workspace you want to rename. Use the Workspace switch in

the middle of the Front Panel.

2. Use �Tab� and the arrow keys until you reach the Rename Workspace button.

3. Press �Enter� to open the Rename Workspace dialog.

4. Tab to the Workspace �eld, back space until the current workspace name is

deleted, and then enter the new workspace name. The workspace name can

be more than one word.

5. Press �Enter�.
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Using Controls in Application Windows

Windows contain standard sets of controls to help you manipulate the

application's data. The �gure below shows a typical application window with

some of these controls.

Application windows have several controls.

Text �elds provide an area where you can type information.

Lists display a list of choices from which you can select.

Scroll bars provide a means to display text that extends beyond a window's

display area.

Buttons execute commands, start actions, or specify options and settings.

Types of buttons include push buttons, toggle buttons, and radio buttons.
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Entering Text Into an Empty Field

A text �eld accepts information you type.

Mouse

1. Click the �eld to get the text insertion cursor.

2. Start typing.

Keyboard

1. Press �Tab�, �Shift�+�Tab�, or the arrow keys until you reach the �eld.

2. Start typing.

Editing Text in a Field

Mouse

1. Select the text in the �eld to edit:

Character(s): Move the pointer to the �rst character and drag the pointer

to the last character.

Word: Double-click the word.

Line: Triple-click the line.

Multi-line �eld: Quadruple-click the �eld.

2. Type the replacement text.

Keyboard

1. Press �Tab�, �Shift�+�Tab�, or the arrow keys until you reach the �eld.

2. Use the editing keys to edit its contents.
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Editing Keys

Arrow Keys � 	 � � Move the text insertion cursor.

�Backspace� Delete the character before the cursor.

�Delete char� or �Del� Delete the character following the cursor.

�CTRL� and �Delete char� or
�CTRL� and �Del�

Delete all the characters from the cursor to the end

of the current line.

Cutting and Pasting Text into Windows

Cutting and pasting eliminates the need to retype text. You can cut from and

paste into:

Text �elds.

Terminal windows.

Editor windows.

Cutting Text

1. Move the pointer over the �rst character you want to cut.

2. Press and hold down mouse button 1.

3. Drag the pointer over the text you want to move. The text appears

highlighted.

4. Release mouse button 1 after all the text you want to cut is highlighted.

The highlighted text is copied to an internal \clipboard". The text is not

removed from your original source.

Pasting Text

1. Position the cursor where you want to insert the text.

2. Click mouse button 2. A copy of the contents of the clipboard is pasted at

the location you indicated. You can make additional copies by repeating the

above steps.

3. To unselect text, click mouse button 1 in an empty area of the window that

has the text selected, or press �ESC�.
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When you cut text, it is stored temporarily in a bu�er. This bu�er can hold only

one item at a time. If you cut another piece of text before pasting the �rst

piece, the second piece of text will overwrite the �rst in the bu�er.

Choosing a List Item

A selected list item is highlighted. The selected item is acted upon when a

command, such as OK, is chosen.

Selected list items are highlighted.

Mouse

1. Click the list item.

2. Choose a command, such as OK.

Note In some lists, double-clicking an item selects the item and

chooses the default command.

Keyboard

1. Tab to the list.

2. Select the list item:

In a single-selection list, use the arrow keys to reach your choice.

In a multiple-selection list, use the arrow keys to reach your choice, then

press the space bar. To unselect the item, press the space bar again.
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Single- and multiple-selection lists are available.

3. Choose a command, such as OK.

Scrolling the Contents of a Window

On many occasions you will need to scroll a window in order to see text that is

beyond the size of the window, either horizontally or vertically. Horizontal and

vertical scroll bars let you accomplish this easily.

Mouse

Use the scroll bar.
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Scroll bars let you view all
of a window's contents.

Click the top arrow to go up one line.

Click in the trough above the slider to go up one page.

Drag the slider to scroll incrementally.

Click in the trough below the slider to go down one page.

Click the bottom arrow to go down one line.

Keyboard

1. Move to the window area you want to scroll.

2. Use the arrow keys, �Prev� and �Next�, or �Pg Up� and �Pg Down�.

Choosing a Push Button

Choosing a push button immediately performs the associated command or

action. For example, choosing an OK button applies any changes made to a

dialog, then closes it.

Mouse

Move the pointer over the button and click mouse button 1.
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Keyboard

1. Use �Tab� and the arrow keys until you reach the button.

2. Press �Enter�.

Selecting a Toggle Or a Radio Button

Toggle buttons are square-shaped, and you can select as many as you want.

Radio buttons are diamond-shaped, and you can select only one at any time.

Example radio and toggle buttons.

Selecting a toggle button speci�es the action or setting to occur when a

command, such as OK, is performed. Selecting a radio button also speci�es an

option or setting, but only one radio button in a group can be selected at a time.

Mouse

Move the pointer over the button and click mouse button 1.

To unselect the button, move the pointer over a selected button and click mouse

button 1.

Keyboard

1. Use �Tab� and the arrow keys until you reach the button.

2. Press the space bar.
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Using Sliders

Sliders are controls that you use to adjust the value of some application

parameter. In many cases, the value is displayed near the slider.

Use slider controls to adjust values.

Mouse

1. Move the mouse pointer over the slider

2. Press and hold mouse button 1.

3. Move the mouse so that the slider moves in the desired direction.

4. Release the button when you have �nished.

Keyboard

1. Press �Tab� or an arrow key until you reach the slider.

2. Use the arrow keys to move the slider incrementally.

Note To move the slider faster, press and hold �CTRL�, and then press

the arrow key.
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The HP VUE Terminal Window

A terminal window (or terminal emulator) is a window that allows you to type

commands. Part II of this guide describes common HP-UX commands.

Terminal windows are like user terminals connected to your system. You may

have several terminal windows open at the same time and execute commands in

each terminal window separately.

The command line prompt is a special character that is displayed at the left

edge of your terminal window. The prompt can be a $, >, %, or other special
character. A small rectangle, called a cursor, shows where characters will appear

in the window when you type something on the keyboard.

The command line prompt and cursor appear in terminal windows.

HP VUE provides three types of terminal windows:

hpterm hpterm is the default terminal window for HP VUE. Its

command line prompts and softkeys act like an HP Term0

terminal.

dtterm dtterm provides an EUC 4-byte capable terminal emulator. It

emulates the DEC VT220 terminal emulator. For more details,

see the dtterm manual reference page or start a dtterm
window and choose Help to read the online help. (If the menu

bar is not visible, display the dtterm window menu and choose

\Toggle Menubar".)

xterm xterm provides a terminal window that emulates DEC VT102

and Tektronix 4014 terminals. xterm is provided for backward
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compatibility with previous HP-UX releases. xterm users are

encouraged to use either hpterm or dtterm instead. For more

details, see the xterm manual reference page.
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Starting and Stopping a Terminal Window

You can start an HP VUE terminal window either with a Front Panel control,

from the File Manager, or by typing a command. The method of stopping the

terminal window is the same, regardless of how it was started.

\Using Terminal Windows with HP VUE Lite" explains how to start a terminal

window in HP VUE Lite.

\Using a Non-English Terminal Emulator" in Chapter 27 of the HP Visual User
Environment 3.0 User's Guide explains how to run a terminal window with

non-English characters. Or, see HP VUE's online help. Click the Help Manager

control, then click "HP Visual User Environment Version 3.0 Help", then click

\General Con�guration", then click \Non-English HP VUE Sessions".

Starting a Terminal Window from the Front Panel

Choose the Terminal control in the Front Panel.

Use the terminal control to start a terminal window.

A default terminal window containing a command line prompt and cursor

appears.

Starting a Terminal Window from File Manager

Choose \Terminal" from the Directory menu.

This opens a Terminal Window with the same current working directory as the

File Manager view where it is started.
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Starting a Terminal Window from the Command Line

At the command line prompt, type the name of the terminal window and any

options you want, using:

hpterm [options] &

dtterm [options] &

xterm [options] &

Where:

options Represents optional items to customize the terminal window.

See the hpterm, dtterm, or xterm manual reference pages for

details about the options available for each.

& Speci�es that the terminal window runs in the background, that

is, you can continue working in your original window while the

terminal window is also running.

The terminal window starts in the current workspace unless directed otherwise

by options.

Examples

The following command starts an hpterm window with a black background and

a white foreground.

hpterm -bg Black -fg White &

The following command starts an xterm window in the workspace named

\Project Notes":

xterm -xrm '*workspaceList: "Project Notes"' &

The following command starts an hpterm window on a screen on the system

named \LGMCD":

hpterm -display LGMCD:0 &
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Starting a Terminal Window from the Toolbox

Execute the hpterm, dtterm, or xterm action in the Utilities subdirectory of the

General Toolbox directory.

Closing a Terminal Window

Menu Button

Double-click the window menu button in the window frame.

Or, choose \Close" from the window menu.

Close a terminal window with the window menu button.

Command Line

Type:

exit �Enter�
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Using the Terminal Window

The terminal window lets you enter HP-UX commands and cut and paste text

between and within windows.

Cutting and Pasting Text

You can select text within one window and copy it to another location within

that window, or to another terminal window. The original text is unchanged. If

you want to delete it, you must do so manually. To cut and paste in terminal

windows, see \Cutting and Pasting Text into Windows".

Note that cutting or pasting in Text Editor uses a di�erent method (see \Editing

Text" in Chapter 6).

Starting Applications in a Terminal Window

Enter the command to start the application at the command line prompt.

The general syntax for starting an application is:

application [options] &

application The application name.

options A list of optional information to be passed to the application.

& Indicates that the application runs in the background; that

is, you can continue to use the terminal window while the

application is running.

See the documentation for each application to for information on the command

and options to use.

Example

The following example starts a digital clock from the command line:

xclock -digital & �Enter�
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Using Terminal Windows with HP VUE Lite

HP VUE Lite provides terminal windows on both local and remote systems.

Terminal Control

Choose the Terminal control on the Front Panel.

The default terminal window will display a window containing a command line

prompt and a cursor.

Use the HP VUE Lite terminal control to start a terminal window.

Menu

1. Choose the arrow above the Terminal control on the Front Panel.

2. Select one of the choices from the subpanel:

Make a selection from the terminal subpanel.
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3. If you chose a remote terminal window, a dialog box appears. Enter the

name of the system you want to log on to.

Enter the host name in the Host Dialog.

\Displaying a Terminal Window on Another System" in Chapter 12 explains how

the terminal window can run on another computer.
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4

Getting Help

Hundreds of online help topics are at your �ngertips while you're using HP

VUE.

Note Desktop HP-UX does not contain all of the standard online help.

For example, it does not contain the online help for this guide,

or the "HP-UX Operating System Help".

If you want to . . . See page . . .

Learn about the ways to get help 4-2

Get application help 4-6

Learn to use hyperlinks 4-9

Browse help with Help Manager 4-14

Display a man page 4-17

Print help topics 4-20
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Ways to Get Help

Here are the ways you can request help:

Press �f1�|also known as the \help key"|to get context-sensitive help.

Choose a command from an application's Help menu.

Open Help Manager to browse all the available help.

Use the Help subpanel.

By default, online help is displayed with black text on a white background. To

change these colors, see \Changing the Help Topic Display Colors" in Chapter 12.

To set up a help server, which is a computer on a network that other systems

can use to access online help �les, see Chapter 4 of the HP Visual User
Environment 3.0 User's Guide.

Press f1, the \Help" Key

The quickest and easiest way to get help when you get stuck is to press �f1�.
When you press �f1�, the application you are using displays the help topic most

closely related to your current activity.

Some computers have a dedicated \Help" key on the keyboard. If yours does, it

may take the place of the �f1� key.

Use the Help Menu

Most applications have a Help menu that contains additional commands

for requesting speci�c kinds of help|such as \Introduction," \Tasks," and

\Reference."

To learn more about using help windows, choose \Using Help" from the Help

menu in any HP VUE application. Or, you can press �f1� while using a help
window.

Browse Help with Help Manager

The HP VUE Help Manager is a special help window that lists all of the online

help installed on your system. An online help volume is the help associated with

a speci�c application.

1. Choose the Help control in the Front Panel.
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Browse help by choosing the Help control.

2. Scroll through the list of help titles and choose a title. "Using Your HP
Workstation" contains the online help corresponding to Part I of this guide.

"HP Visual User Environment Version 3.0 Help" contains the online help

corresponding to the HP Visual User Environment 3.0 User's Guide,
including HP VUE administration and con�guration tasks.

3. After choosing a title, another screen appears listing the volumes of help

available for that title. To open a volume, choose its title.

Use the Help Subpanel

You can also use the Help Subpanel to access several kinds of help.

1. Choose the Help Subpanel control (the small arrow above the Help control on

the Front Panel). The Help Subpanel appears.
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The Help subpanel contains several kinds of help.

2. Choose any of the categories in the Help Subpanel:

Top Level Equivalent to choosing the Help control. It opens a

window with a list of help titles.

Welcome Displays a welcome message for your workstation.

Man Page Lets you type the name of a manual reference page (man

page) to view.

On Front Panel Displays a help window with information about using the

Front Panel.

On Item Changes the pointer to a question mark. To get help

on an item, drag this pointer to any of the front panel

controls, a Workspace Manager dialog, or a subpanel

control and click mouse button 1. For example, to see

help for the Style Manager, drag the question mark to the

Style Manager control and click mouse button 1.
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Getting Help Within an Application

The HP Help System is built into each of the HP VUE applications (and possibly

other applications installed on your system). When you ask for help while using

an application, the application displays a help window.

The HP Help System provides two types of help dialogs that applications may

use:

General help dialogs have a menu bar, a Topic Hierarchy (that tells you where

you are), and a help topic display area.

Quick help dialogs have just a topic display area and one or more dialog

buttons at the bottom.

HP VUE applications provide help dialogs.
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Displaying Context-Sensitive Help

Press �f1�|the \help key."

Or, if you are using a dialog box, choose the dialog's Help button.

When you ask for context-sensitive help within an application, the application

determines which help topic is most appropriate. Many applications have

been designed to display help that is appropriate for your current situation or

context.

Displaying Other Application Help

To obtain other application help, move the pointer to \Help" in the application

menu bar at the top of the application window, and click mouse button 1. The

application help menu appears.

Applications provide help menus.

Choose one of the following commands from the application's Help menu:

Introduction Displays the home topic for the application. The home topic
is the main topic at the top of the application's help topic

hierarchy. Hyperlinks in the home topic lead to all other help

topics.

Tasks Displays task instructions for most operations performed within

the application.

Reference Displays reference summaries for various features, such as

windows and dialogs, menus, and resources.

On Item Lets you select an item in any of the application's windows,

then describes the item you have selected.
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Using Help Provides help on using the help system.

Version Displays the version and copyright information for the

application.

Non-HP VUE applications may have di�erent commands in their Help menus.
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Using Hyperlinks

You move from topic to topic within help by using hyperlinks. Any underlined

text in a help window is a hyperlink. Choosing a link (with the mouse or the

keyboard) immediately jumps to another related topic.

A solid underline indicates a standard jump (the related help topic is displayed

in the same window). A dashed underline indicates a de�nition link, which is

displayed in a popup de�nition window.

Hyperlinks are underlined.

Some Links Display a New Window

Most hyperlinks display the related topic in the same window. However, if

a hyperlink jumps to a help topic for another application, a new window is

displayed. Links that jump from one application's online help into another's, are

called cross-volume or cross-application hyperlinks.

Knowing Where You Are

Since hyperlinks can quickly take you from one piece of information to another,

it is sometimes helpful to know where you are. The Topic Hierarchy list in

general help dialogs provides this information.
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The Topic Hierarchy shows you where you are.

The �rst item in the list is the home topic, or top, of the current help volume.

(Usually there's one help volume per application.) Each item below the home

topic represents a decreasing level of hierarchy down to the last item, which is

always the current topic.

As you follow hyperlinks, you will notice the titles in the Topic Hierarchy list

changing to re
ect your current location.

Knowing Where You've Been

Each general help dialog keeps track of the 20 most recent topics that you have

visited. To display this list, choose History from the Search menu. The History

dialog lists the title of each topic (most recent topic on top).

The History dialog shows you where you have been.
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To return to a particular topic, double-click its title in the list. When you are

done, choose \Close."

Finding a Topic By Exploring

1. Choose hyperlinks to jump to related topics.

2. Use the Topic Hierarchy list to jump \up" to a higher-level topic.

3. Return to the home topic by choosing \Home Topic" from the Navigate menu.

4. Go back to the previous topic by choosing \Backtrack" from the Navigate

menu or from the popup menu in the topic display area. You get the popup

menu by clicking mouse button 3 with the pointer in the topic display area.

5. Use the Keyword Index to locate topics that cover a certain subject. (Choose

\Keyword" from the Search menu.) See \Finding a Topic By Keyword".

Finding a Topic By Keyword

Note The keyword search is not available at the highest levels of

help. The scope of the keyword index is limited to the current

help volume. There is no global index of keywords for all online

help.

For example, to perform a keyword search on the online help

for this manual, click the Help Manager control, click \Using

Your HP Workstation" (you may have to scroll down to see it),

then click \Using Your HP Workstation" in the introductory

screen that appears. A new help window opens with a list of

hyperlinks. In this new window, the keyword index is now

available and can be searched.

1. Choose \Keyword" from the Search menu to display the Keyword dialog.
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Use the Keyword dialog to search help.

2. Optional: Type all or part of the keyword you are looking for into the

\Keyword Filter" �eld. As you type, the keyword list is shortened to show

only the keywords that begin with the characters you type in (case is

ignored).

3. In the \Select a Keyword" list, select the keyword you are looking for.

4. In the \Select a Topic" list, select the title of the topic you want to view. The

topic you select is displayed in the help dialog.

You may view as many topics as you want. When you are done, choose Close.
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Browsing Help on Your System

The HP VUE Help Manager lets you browse the online help installed on your

system. At the top level, Help Manager lists all of the product families that
have installed help.

Use the Help Manager to browse help.

The previous �gure shows the Help Manager window with \Using Your HP

Workstation". You may have to scroll the window on your screen before \Using

Your HP Workstation" is visible.
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If you open a product family, you see a list of help volumes installed for that

product. To open a particular help volume, choose its title.

Opening A Help Volume Using Help Manager

1. Choose the Help Manager control in the Front Panel (the books with a

question mark). A general help dialog is displayed, listing all of the product

families with online help. This is the top level of Help Manager.

2. Scroll the window to �nd the title of the product family you are interested

in. Then choose its title (underlined). For example, choose \Using Your HP

Workstation".

3. A screen appears that lists the topics (volumes) available for that title.

To open a volume of help, choose its underlined title. In this example, you

would choose \Using Your HP Workstation" again.

4. A new window appears that contains the �rst screen of help for the volume

you selected.
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A new help window appears.

Choose hyperlinks in this window to view the subjects you're interested in.
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Displaying a Man Page

Manual reference pages, traditionally known as \man pages," provide

information on all HP-UX commands, Xt Intrinsics functions, OSF/Motif

functions and widgets, and almost all contributed functions. You can display any

man page using the Man Page control in the Help subpanel.

Note Online man pages are not included in Desktop HP-UX. See the

HP-UX Reference.

Use the Man Page control to view man pages.

Displaying a Man Page from the Help subpanel

1. Choose Man Page from the Help subpanel. A dialog box appears, prompting

you to enter a man page name.

2. Enter the name of the man page you want to see.

3. Choose \Show Man Page".

You may repeat steps 2 and 3 as many times as you want to view additional man

pages. When you are done, choose Exit.
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Example

To display the man page for the vuewm command, �rst choose \Man Page" from

the Help subpanel. A dialog is displayed, prompting you for the man page

name. Move the mouse pointer into the recessed shaded area to the right of

\Man Page: " (this area is called the \name �eld"), and click mouse button 1. A

blinking cursor in the shape of an \I-beam" appears, indicating that the name

�eld is active for you to enter data. Enter the string \vuewm" into the name
�eld . . .

Type the name of the man page.

. . . then choose \Show Man Page."

Man pages are displayed in a quick help dialog.
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When you're done, close the man page by choosing OK. To display another man

page, enter its name just as you did for vuewm. When you are done viewing man

pages, choose Exit.
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Printing Help Topics

Sometimes it is useful to have a printed version of a help topic|or even a whole

help volume|for a particular application. The HP Help System lets you print

help topics to LaserJet Series II or Series III printers. (The default is Series III.)

When you print a topic, it is formatted just as it is on the display. Color graphics

are automatically dithered to black and white.

1. From a help browser window, choose \Print" from the File menu to display

the Print dialog.

2. Select the topics you want to print:

Print All|to print all topics.

Print Current Topic|to print only the current topic (the default).

Print Current and Down|to print the current topic and its subtopics.

3. Choose OK.

From a quick help dialog, the Print button immediately prints the current topic,

without displaying the Print dialog.

Printed output from HP Help is directed to your default printer. To change the

default printer, see \Choosing Printers for Online Help" in Chapter 10.
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5

Working with Files

To help organize and maintain the �les and directories you use, HP VUE

provides these tools:

File Manager is an application for managing �les and directories.

The Desktop allows you to place any �le or directory icon directly on the

workspace backdrop for easy access.

Toolboxes are special File Manager views for managing applications and other

software available to you. You can also �nd information about toolboxes in

Chapter 9.
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Introducing File Manager

The HP VUE File Manager is an application that displays �les and directories as

icons. Using a mouse, you can manipulate the icons directly by dragging and

dropping them into place. For example, to print a �le, simply drop it on the

printer in the Front Panel.

File Manager associates a meaningful icon with each �le and directory based on

its �letype. More importantly, actions associated with each �letype de�ne the

desired behavior for the �le or directory.

For instance, you might have a �letype that identi�es document �les. The

default action|performed by double-clicking the �le's icon|would open the �le

for editing. That is, the action saves you the trouble of remembering and typing

the command to start your word processor. The action automatically starts your

word processor and loads the �le. Additional actions may provide shortcuts to

other frequent tasks, such as printing the document.

Note File Manager is not available in HP VUE Lite. If you are using

HP VUE Lite, you must type commands in terminal windows to

manipulate �les and directories. Part II of this guide contains

more information on using HP-UX commands.

The �gure below shows a few of the common icons you may encounter while

using File Manager:

File Manager uses several types of icons.
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Note For information on annotating �les with text or audio, see the

HP Visual User Environment 3.0 User's Guide. Or, see HP
VUE's online help. Click the Help Manager control, then click

"HP Visual User Environment Version 3.0 Help", then click

\File Annotator".
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Introducing the Desktop

The HP VUE Desktop occupies each workspace. It's a handy place to put the

�les, directories, actions, and applications that you use most frequently.

To place an object on the Desktop, you drag its icon from a File Manager or

Toolbox window, then drop it on the workspace backdrop. A Desktop icon

appears where you drop the object.

You use Desktop icons exactly like the icons in the File Manager or Toolbox. To

execute an object's default action, double-click its icon on the Desktop.

Each Desktop object also has a popup menu containing additional commands

and actions for the object. To display the popup menu for a Desktop object

using the mouse, point to the icon, then press and hold the right mouse

button. To display the menu with the keyboard, use �Alt�+�Tab� until the icon is

highlighted, then press �f4�.

Note The Desktop is not available in HP VUE Lite.

The Desktop for �ngertip access

Any �le, directory, or action that you access frequently can be placed directly

on the Desktop for quick access. The Desktop occupies the entire backdrop in

each workspace. In fact, since HP VUE has six workspaces by default, you

e�ectively have six separate Desktops.

When you put an object on the Desktop, the original object is not altered. Each

Desktop object is really just a reference to the actual object that remains in its

original location.

You can leave objects on the Desktop as long as you want. Their locations are

remembered when you log out and restored when you log in again.
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The Hierarchical File System

If you are new to computers, the idea of a \hierarchical �le system" may be

new to you. Here are the basic concepts . . .

What's a �le?

A �le is a named container for information. Most of the �les you use contain

data of some particular format|a document, a spreadsheet, a chart.

Most applications understand a limited number of �le formats. For example, a

document editor may not be able to read a spreadsheet �le. HP VUE helps you

recognize di�erent types of �les using a �letype database. A �letype identi�es

the �les of a particular format and associates them with the appropriate

applications. These associations mean you don't have to remember commands to

accomplish frequent tasks.

On some computers, �le names cannot be longer than 14 characters. If you are

not sure if your computer can support longer �le names, check with your system

administrator.

What's a directory?

A directory is a container for �les, similar to a folder in a �le cabinet. Since a

directory can contain other directories|sometimes called subdirectories|you

can create multiple levels of organization that form a hierarchy.

Within any single directory, each �le name must be unique. However, �les in

di�erent directories may have the same name.

As you navigate from directory to directory, your current location is referred to

as the current working directory.

What's a path?

The location of a �le is often speci�ed using the directories and subdirectories

that lead to the �le|this is called a path. An absolute path speci�es a path

from the root directory to the �le. For example, this is an absolute path to the

�le sys.vuewmrc:

/etc/vue/config/sys.vuewmrc

Here's a diagram showing that path:
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An absolute path in the hierarchical �le system.

A relative path speci�es a path from the current directory to the �le. If a path

does not begin with a slash, it is a relative path. For example, if the current

working directory is /etc/vue/, the relative path to the sys.vuewmrc �le is:

config/sys.vuewmrc

Two special directory names are useful for specifying relative paths. The ./
directory (sometimes called \dot") represents the current working directory.

The ../ directory (sometimes called \dot-dot") represents the parent directory|
the directory one level up in the directory hierarchy. For example, if your

current working directory is /etc/vue/config/panels/, then the relative path

to the sys.vuewmrc �le is:

../sys.vuewmrc
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Note You may be used to computer systems that use the \ character

to separate the components of a path name (for example,

\work\myfile). Note that UNIX uses the / character instead

(for example, /work/myfile).
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File Ownership and Security

For more general information on security, see Chapter 18 in Part II.

Three groups of users can access �les: owner, group, and other. File access is
divided into three functions: read permission, write permission, and execute
permission.

Who Has Access?

The three basic classes of users are:

Owner|Usually the person who created the �le.

Group|Several users that have been grouped together by the system

administrator. For example, the members of a department might belong to the

same group.

Other|All other users on the system.

What Kind of Access?

The access permissions on a �le specify how that �le can be accessed by the

owner, group, and other.

Read Permission|Allows access to retrieve or view the contents of the �le

or directory.

Write Permission|Allows access to change the contents of the �le or

directory.

Execute Permission|For a �le, allows access to run the �le (for executable

�les and scripts). For a directory, allows you to view the contents of �les

within the directory, and to run commands, scripts, and actions within that

directory.

With File Manager, you can view and change the access permissions for any �le

or directory. See \Changing the Owner of a File or Directory" and \Changing

Access Permissions" later in this chapter.

Examples

To make a directory private:

Change the directory's properties, giving yourself (the \owner") read, write,

and execute permission, but give no permissions for \group" and \other."

Then only you and the superuser can view the directory contents.

5-8 Working with Files Part I: Using HP VUE



To make an action that you have created available for everyone to use, but

protected so it is not inadvertently overwritten:

Change the �le's properties, giving read and execute permission to \owner,"

\group," and \other." Don't give anyone write permission.

Default Permissions

The default permissions used when you create a new �le or directory may be

altered by your system administrator. To determine your current defaults, create

a new �le or directory, then choose \File" in the File Manager menu bar, then

choose \Properties". To change your default permissions, ask your system

administrator.

Choose \Properties" to view permissions.
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Basic File Management Skills

To get started using File Manager, you need to learn a few basic skills:

Selecting|Many commands operate on the \selected" �le or directory.

Dragging and Dropping| If you use a mouse, the easiest way to perform

many operations is to manipulate the icons with the mouse.

Using Popup Menus|Each icon displayed by File Manager has its own popup

menu, including objects on the Desktop. Each popup menu provides shortcuts

to many common operations.

Starting File Manager

Mouse

Move the pointer over the File Manager control and click mouse button 1.

Choose the File Manager control.

Keyboard

1. Press �Alt�+�Tab� until you reach the Front Panel.

2. Use the arrow keys to move the highlight to the File Manager control.

3. Press �Enter� to choose the control.

Selecting a Single File or Directory

Mouse

Click the object's icon.

Keyboard

1. Use the �Tab� and direction keys to move the highlight to the object you want

to select.
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2. Press �Enter� or the space bar.

The selected object is highlighted.

When you select an object, its icon is highlighted and its name is displayed in

inverse video. File Manager's menus apply to the selected object. In particular,

the Actions menu always contains the actions that can be performed on the

selected �le or directory. If no icons are selected, the entire Actions menu (and

some commands in other menus) is inactive.

To select multiple objects, hold down �CTRL� while selecting.

To deselect an object, select another one or click an empty area within the File

Manager window.

Selecting Multiple Files and Directories

There may be times when you want to select multiple objects simultaneously.

For example, you may need to do one or more of the following tasks:

Delete several �les at once.

Move a group of �les to a new directory.

Put several objects on the Desktop.

Mouse

Drag a box around the objects you want to select. (Press mouse button 1 in

a blank area of the view, drag to draw a box, then release to select the icons

included in the box.)
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Or, click to select the �rst object, then hold down �CTRL� and click to select

additional objects.

Keyboard

1. Select the �rst object.

2. For each additional object you want to select, move the highlight to its icon,

then press and hold �CTRL� while you press �Enter�.

When multiple icons are selected, dragging any one of the selected icons drags

the whole group.

Also, when multiple icons are selected, the Actions menu and some commands

in other menus are inactive.

Renaming a File or Directory

Mouse

Select the object's name, type the new name, then press �Enter�.

Keyboard or Mouse

Choose \Rename" from the File menu, type the new name, then press �Enter�.

To cancel a rename operation, press �Esc�.

Getting Help on a File or Directory

Mouse

Select the object, then press �f1�.

Or, choose \On Item" from the Help menu, then click the object's icon.

Keyboard

Move the keyboard highlight to the object's icon, then press �f1�.

The description displayed when you ask for help on an icon describes the

�letype associated with the �le or directory. The description is speci�ed in the

�letype de�nition.
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Opening a File or Directory

Double-click the object's icon.

Or, select the object's icon, then choose a command from the Actions menu

that opens the �le or directory. (The Actions menu contains di�erent

commands depending on the �letype of the selected object.)

Or, choose a command from the object's popup menu.

Double-clicking an icon executes the object's default action, which is always the

�rst command in the Actions menu. For most data �les, the default action opens

the �le by starting the appropriate application and loading the �le.

Directories have actions de�ned to open them (either in place, using the current

File Manager window, or in a new window).

For information on opening �les or directories on remote systems, see

Chapter 11.

Dropping a File or Directory

1. Point to the object's icon.

2. Press and hold mouse button 2, known as the \drag" button. (On a

two-button mouse, press both buttons simultaneously.)

3. Drag the icon to the location where you want to drop it, then release the

mouse button.

Hold down mouse button 2 to drag an object.

So, the motion for dropping an object is press . . . drag . . . release.

To cancel a drag in progress, press �Esc� before releasing the mouse button.

If more than one icon is selected, you drag the entire group by dragging any of

the selected icons.
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Note You cannot drag and drop an object with the keyboard. You

must have a mouse.

What Happens When You Drop a File Icon

If you drop an object into an open File Manager window or into a directory

icon, the �le is moved to that directory.

If you drop an object onto the workspace backdrop, the object is placed

on the Desktop in the current workspace. A Desktop object is really just a

reference to the real object, which remains unchanged.

If you drop a �le on the Printer control in the Front Panel (or one of the

printers in the Printers subpanel), the �le is printed.

If you drop a �le on the Personal Toolbox control in the Front Panel, the

object is copied into your Personal Toolbox.

If you drop a �le on the Trash control in the Front Panel, the object is moved

into the Trash Can.

If you drop a �le on an action icon, the action is invoked with the �le as a

parameter.

If you attempt to drop the icon in a location that does not support dropped

objects, the icon snaps back to its original location in File Manager or on the

Desktop.

Displaying a Popup Menu

Mouse

1. Point to the icon whose popup menu you want to display.

2. Press mouse button 3|the \popup" button.

3. To choose a command from the menu, drag to the command, then release.

Or, click the command.

Keyboard

1. Using the �Tab� and arrow keys, move the highlight to the icon whose menu

you want to display.

2. Press �f4�.
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3. To choose a command from the menu, use the arrow keys to highlight the

command, then press �Enter�.

To cancel the menu without choosing a command, press �Esc�.
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Manipulating Files and Directories

The major identifying features of a �le or directory are:

Its name and location in the �le hierarchy.

Its owner and permissions (properties).

Whether or not it is linked to another �le. A linked �le is a representation of

another �le. Linked �les provide a way for you to have one �le that appears

to exist in two or more directories. (See \Creating a Symbolic Link".)

Creating a New File or Directory

1. Choose New . . .

From the File menu to create a new �le.

Or, from the Directory menu to create a new directory.

A dialog box prompts you for the name of the new �le or directory.

2. Enter the new name.

3. Choose OK.

There are other ways to create objects:

Copy an existing object, then rename it.

Create a new �le within an application. For example, if you use Text Editor to

write a new text �le, when you save it for the �rst time, a new �le is created.

Moving a File or Directory

Mouse

1. Be sure the destination directory is visible (either as an icon or as an open

File Manager view).

2. Drop the icon into its new directory.
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Note If you move a directory, the entire directory and its contents

are moved.

If you attempt to move a �le or subdirectory from a directory

where you do not have permission to make changes, File

Manager may create a copy of the object, and display a \File

Manipulation Error" indicating that you cannot delete the

original �le.

For HP VUE Lite

Since File Manager is not available in HP VUE Lite, you must use the mv
command to move and rename �les. Open a terminal window (see \Starting and

Stopping a Terminal Window" in Chapter 3), then execute the mv command like

this:

mv old�le new�le

Or, to move one or more �les into an existing directory:

mv �les directory

The following example moves star.xwd into the /home/jodi/Graphics
directory:

mv star.xwd /home/jodi/Graphics �Enter�

File and directory names may include a path, if needed. See \The Hierarchical

File System".

Copying a File

Mouse

1. Be sure the destination directory is visible (either as an icon or as an open

File Manager view).

2. Press and hold �CTRL� while dragging the �le's icon, then drop the icon into

the directory where you want the copy.

Keyboard

1. Select the �le's icon.

2. Choose \Copy" from the File menu. A dialog displays, prompting you for the

name of the new copy.
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3. Enter a name for the new copy of the �le and choose OK.

Note You cannot use the Copy command to copy directories.

However, the HP-UX command cp -r copies a directory and

its contents. See the HP VUE Lite procedure below for more

information.

For HP VUE Lite

Since File Manager is not available in HP VUE Lite, you must use the cp
command (copy), to copy �les and directories. Open a terminal window (see

\Starting and Stopping a Terminal Window" in Chapter 3), then execute the cp
command like this:

cp old�le new�le

Or, to copy a directory and its entire contents:

cp -r directory newdirectory

The following example copies mydir and any subdirectories to a new directory

called mydir2.

cp -r mydir mydir2 �Enter�

File and directory names may include a path, if needed. See \The Hierarchical

File System".

Creating a Symbolic Link

A symbolic link is a type of �le that contains only a path name (a \pointer")

to the place where the actual data is stored. Using this procedure avoids

duplication of large �les, and saves space.

Mouse

Press and hold �Shift� while dragging the object's icon. When you drop the icon

into a new directory, a symbolic link is created in that directory that points to

the original object.

Keyboard

1. Choose \Terminal" from the Directory menu in File Manager. This opens a

terminal window with the same current working directory.

2. Use the ln command to create the symbolic link:
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ln -s �lename linkname

Where �lename is a complete path to the existing �le, if it is not in the

current directory, and linkname is the name of the symbolic link, which may

also be a complete path.

For example, to create a symbolic link from /home/leslie/myfile to the

existing �le /home/leslie/work/newfile, use this command:

ln -s /home/leslie/work/newfile /home/leslie/myfile �Enter�

Users can now access /home/leslie/work/newfile by accessing

/home/leslie/myfile.

3. Close the terminal window by choosing \Close" from the window menu or by

executing the exit command.

For HP VUE Lite

Since File Manager is not available in HP VUE Lite, you must use the keyboard

method above.

Changing the Owner of a File or Directory

There may be times when you need to change the owner of a �le or directory.

For example, you may be moved from one project to another before the �rst

project is complete, and may need to give your replacement on the �rst project

ownership of the directories and �les associated with the project.

1. Select the object's icon.

2. Choose \Properties" from the File menu or from the object's pop-up menu.

File Manager displays the File Properties dialog.

3. Make the desired changes:

To change the �le's owner, type the new owner's name into the \Owner

Name" �eld.

To change the �le's group, type the new group name into the \Group

Name" �eld.

See \File Ownership and Security" for more information.

4. Choose OK.
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Note If you give ownership of the �le to another user, you will

not be able to change the permissions again unless that user

returns ownership to you.

If you do not have permission to change the properties, some

of the controls in the File Properties dialog are inactive.

Changing Access Permissions

You can change the access permissions to directories and �les you own. You

might need to do this if your manager assigns other people to work with you

and they need access to your �les.

1. Select the object's icon.

2. Choose \Properties" from the File menu. File Manager displays the File

Properties dialog.

3. In the Permissions box, select the permissions for the �le or directory's

owner, group, and other:

Select \Read" for the users that should be allowed to read the �le or

directory.

Select \Write" for the users that should be allowed to alter the �le or

directory.

Select \Execute" for the users that should be allowed to execute the �le or

access �les in the directory.

See \File Ownership and Security" for more information.

4. Choose OK.

The object's owner is identi�ed in the Owner Name �eld. The object's group is

identi�ed in the Group Name �eld.

Read, write, and execute permissions are selected in the Permissions box. The

permissions selected in the Group row indicate the access privileges for any user

belonging to the named group. The permissions selected for the Other row apply

to all other users.
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Navigating to Directories and Subdirectories

File Manager is like a vehicle that you drive to tour the �le system on your

computer and other computers on the network. Each File Manager window|

also called a \view"|shows the contents of a single directory.

If you are not familiar with hierarchical �le systems, see \The Hierarchical File

System".

Changing to Another Directory

Double-click a directory icon.

Or, select a directory icon, then choose \Open In Place" from the Actions

menu or from the directory's popup menu. (\Open New View" opens a new

File Manager window for the directory.)

Or, double-click a segment of the current path. For example, if the current

directory is /home/aaron/.vue/types, you can change to the /home/aaron/
directory by double-clicking the word aaron.

Or, select the path above the icon area, type the directory you want to view,

then press �Enter�.

Opening a Terminal Window in the Current Directory

Choose \Terminal" from the Directory menu.

This opens a terminal window with the same current working directory as the

File Manager window.

To close a Terminal window, choose \Close" from the window menu, or execute

the exit command.

Executing an Action for a File or Directory

Using the Actions menu:

1. Select the object's icon.

2. Choose the action you want to execute from the Actions menu.

Or, choose the action you want from the object's popup menu.

Or, double-click the object's icon to invoke its \default" action (which is the

�rst action listed in the Actions menu).
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Deleting Files with the Trash Can

The Trash Can collects all of the �les and directories that you delete. They are

not actually removed from the �le system until the trash is \emptied." You can

empty the trash manually, or it is emptied automatically when you log out of HP

VUE.

If you change your mind, and want to restore a �le you have put in the trash,

you can restore it if the Trash hasn't been emptied.

The Trash control in the Front Panel lets you drop objects to delete them.

Choosing the Trash control displays the Trash Can window, which lists the �les

and directories currently in the trash.

Note The Trash Can is not available in HP VUE Lite.

Opening the Trash Can

Choose the Trash control in the Front Panel.

Choose the Trash control.

Or, choose \Show Trash" from File Manager's File menu.

There is only one Trash Can window, shared by all File Manager windows.

Moving a File or Directory to the Trash

Drop the object's icon on the trash can in the Front Panel.

Or, select the object's icon, then choose \Delete To Trash" from the File

menu.

Or, choose \Delete To Trash" from the object's popup menu.

5-22 Working with Files Part I: Using HP VUE



For HP VUE Lite

Since there is no Trash Can in HP VUE Lite, you must use the rm command

(remove) to remove �les. Open a terminal window, (see \Starting and Stopping a

Terminal Window" in Chapter 3), then execute the rm command:

rm �les

Where �les is one or more �le names, separated by spaces.

The following example removes myfile and myfile2:

rm myfile myfile2 �Enter�

File names may include a path, if needed. See \The Hierarchical File System".

Caution Files removed with the rm command are not placed in the Trash

Can, and cannot be restored.

Restoring a File or Directory From the Trash

1. Open the Trash Can.

2. Select the object(s) you want to restore.

3. Choose \Restore" from the Trash Can's File menu.

4. Choose \Close" from the File menu.

Restoring an object from the trash returns it to its original location and removes

it from the Trash Can list.

Note If you delete a �le on a remote system, and then remove access

to that system, you cannot restore the �le until access to the

system is reestablished.

Emptying the Trash

1. Open the Trash Can.

2. Select the object(s) you want to empty from the trash:

Select individual objects in the list.

Or, choose \Select All" from the File menu.

3. Choose \Remove" from the File menu.
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4. Choose \Close" from the File menu.

If there are no objects in the Trash Can, some menu commands are inactive.

Caution When you remove a �le from the Trash Can, it cannot be
recovered.
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Using the Desktop

The Desktop lets you put any �le or directory icon directly on the backdrop

of the current workspace for quick access. Any icon you drop on the Desktop

stays where you put it.

Note The Desktop is not available in HP VUE Lite.

A Desktop in Each Workspace

Since each workspace has its own Desktop, you can set up your working

environment by putting the �les and directories in the workspaces where

you use them most. Objects can be placed on the Desktop in more than one

workspace, if needed.

Placing an object on the Desktop does not alter the original �le or directory. In

fact, the icon that appears on the Desktop is really just a shortcut for accessing

the real �le or directory. Any operation you perform on the Desktop object, is

actually performed on the �le or directory it represents.

Popup Menus

Each Desktop object has its own popup menu, displayed with the right mouse

button or by pressing �f4� when the icon has the highlight. This menu contains

commands for manipulating the object, including all of the actions that appear

in the File Manager's Actions menu when the object is selected.

The Desktop popup menu is similar to the popup menu available within File

Manager windows, but contains a few di�erent commands.

Putting an Object on the Desktop

1. Switch to the workspace where you want the object.

2. Then:

Drop the object's icon on the workspace backdrop.

Or, select the object, then choose \Put On Desktop" from the File menu or

from the object's pop-up menu.

You can repeat these steps to put the object on the Desktop in as many

workspaces as you want.
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Displaying the Popup Menu

Mouse

1. Point to the object's icon.

2. Press and hold mouse button 3.

Use mouse button 3 to display the
desktop icon popup menu.

3. Choose a command from the menu by dragging to the command, then

releasing the mouse button.

Keyboard

1. Move the highlight to the object's icon:

For an object in a File Manager window, use �Alt�+�Tab� to highlight the File

Manager window, then use the �Tab� and arrow keys to move the highlight

to the correct icon.

For a Desktop object, use �Alt�+�Tab� to move the highlight.

2. Press �f4�.

3. Choose a command from the menu by using the direction keys to highlight

the command, then press Enter.

To cancel the menu without choosing a command, press �Esc�.

5-26 Working with Files Part I: Using HP VUE



Removing an Object From the Desktop

1. Switch to the workspace where the object resides.

2. Locate the object's icon on the Desktop

3. Choose \Remove From Desktop" from the object's popup menu.

Removing an object from the Desktop does not alter the original object. The

original object still exists. Only its representation on the Desktop is removed.
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Locating Files

Keeping track of many �les can quickly become too much to remember. File

Manager helps by providing the ability to search for a �le or directory by name.

You can also search for �les based on the contents of the �le.

Finding a File by Name

1. Choose \Find" from the File menu. File Manager displays the Find dialog.

2. Enter the name of the �le or directory you want to �nd into the \File or

Directory Name" �eld.

3. To include symbolic links in the search, choose \On" from the Follow Links

options menu. Otherwise, symbolic links are ignored.

4. Enter the directory where you want the search to begin into the \Search

Directory" �eld. (By default, this �eld contains the current working directory

of the File Manager view.)

5. Choose \Start".

File Manager begins searching the Search Directory and its subdirectories for

�les that match the name you have given. As matches are found, they are

listed in the \Files Found" list. You may stop the search at any time by choosing

\Stop".

Matching Patterns

When you specify a �le or directory name, you can include wildcard characters,

such as asterisk (*) and question mark (?). The * matches any string of

characters (including no characters), and ? matches any single character.

Examples:

vue* Matches all names that begin with the string vue.

*.vf Matches all names that end with the .vf extension.

*.??? Matches all names that have three characters following a dot.
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Finding a File by Contents

1. Choose \Find" from the File menu. File Manager displays the Find dialog.

2. If you leave the \File or Directory Name" �eld empty, File Manager searches

every �le within the Search Directory. If you know the name (or a partial

name) of the �les that contains the search string, you may be able to speed

up the search by also providing a �le name (or pattern) in the \File or

Directory Name" �eld. File Manager examines only the �les that match the

\File or Directory Name" �eld.

3. Enter the string you want to search for into the \File Contents" �eld.

Case is ignored for this string|that is, uppercase and lowercase letters are

equivalent.

4. To include symbolic links in the search, choose \On" from the Follow Links

options menu. Otherwise, symbolic links are ignored.

5. Enter the directory where you want the search to begin into the \Search

Directory" �eld. (By default, this �eld contains the current working directory

of the File Manager view.)

6. Choose \Start".

File Manager begins searching for �les that contain the \File Contents" string.

As matches are found, they are listed in the \Files Found" list. You may stop

the search at any time by choosing \Stop".

Note The �le name and contents can be speci�ed using the same

regular expression syntax allowed by the find command. (See

the �nd(1) man page for more information.)
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Changing File Manager Views

As you become more familiar with File Manager, you may want to change some

settings to better suit your needs or personal preferences. The Preferences

dialog lets you make these changes.

You may also want to customize File Manager by specifying which �letypes you

are not interested in seeing. You can hide certain �les and directories using the

Filter List.

Changing the Icon Sort Order

1. Choose \Set Preference" from the View menu.

2. Select the sort order you prefer from the Order box.

\Alphabetically" sorts all icons alphabetically by name, A-Z (ascending) or

Z-A (descending). Upper-case letters are sorted �rst.

\By File Type" groups icons according to �le type. Within each group of

similar types, the icons are sorted alphabetically.

\By Date" sorts icons according to the last time the �les were modi�ed,

oldest to youngest (ascending) or youngest to oldest (descending).

\By Size" sorts icons by �le size, smallest to largest (ascending) or largest to

smallest (descending).

3. Select the sort direction from the Direction box: Ascending or Descending.

4. Choose OK.

If you have Placement set to \As Placed", icons are sorted only when you

choose \Clean Up" from the View menu or when you choose \Apply" in the

Preferences dialog. If Placement is set to \Sorted Grid", the icons are sorted

each time there's a change to the directory's contents or when you choose

\Reread" from the Directory menu.

Resorting Files and Directories

As you move or delete �les, the icons in the File Manager can start to look

disorganized. To re-sort them, choose \Clean Up" from the View menu.

The \Clean Up" command sorts the objects in the current view (according to the

settings in the Set Preferences dialog) and lines them up in a grid pattern. The

settings in other File Manager windows are not a�ected.
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The \Clean Up" command is inactive if you have the Placement preference set

to \Sorted Grid".

Changing Style of File Manager View

You can control how icons are sorted and placed within File Manager.

1. Choose \Set Preference" from the View menu.

2. Select your preferences (Placement, Show, View, Order, and Direction).

3. Choose OK.

To view the results before closing the Set Preferences dialog, choose Apply.

Saving the Current Preferences as Default

1. Set the preferences that you want using \Set Preferences" and \Modify Filter

List" in the View menu.

2. Choose \Save Settings" from the View menu. File Manager prompts to verify

that you want the current settings saved.

3. Choose OK.

After saving the current preferences, all new File Manager views you open use

the new preferences and �lter list.

Showing Hidden Files and Directories

Hidden �les and directories are those whose �letypes are selected in the

�lter list. By default, the hidden �letypes are DOT FILE, DOT DIR, and

CURRENT DIRECTORY. This means that all �le and directory names that begin

with a dot (.) are hidden. The name of the current directory is represented as .
so it is also hidden.

To hide �les, choose \Show Hidden Files" from the View menu. The \Show

Hidden Files" command is a toggle, so to hide the �les, choose \Show Hidden

Files" again.
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Hiding Files and Directories

1. Choose \Modify Filter List" from the View menu. File Manager displays the

\Modify Filter List" dialog.

2. In the horizontal list of icons, select the icons for the �letypes you want to

hide.

3. Optional: Enter a name pattern into the \Filter String" �eld specifying

additional �le and directory names to be hidden.

4. Choose OK.

If you want to view the results before closing the dialog, choose Apply. To reset

to the default �lter list, choose Reset. This resets the default values but does

not apply them until you choose Apply or OK.

Note The �lter list speci�es which �les are not to be displayed. If you

select all �letypes or enter * into the Filter String �eld, no �les
are displayed.
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6

Editing Files

When you need to do small editing tasks, such as writing memos or notes,

you can use the HP VUE Text Editor. This Text Editor provides basic editing

functions such as copying, deleting, moving, spell-checking, and printing.

If you prefer a di�erent editor, see the section titled \Using Other Editors".
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Using Other Editors

Other editors are available in addition to the HP VUE Text Editor.

You can use vi, the HP-UX editor. vi is the default editor for editing the

commands that you type.

For information on vi, see Chapter 17 in Part II of this guide or The Ultimate
Guide to the vi and ex Text Editors, available from Hewlett-Packard.

You can use the optional Emacs editor. Emacs is a widely used public domain

editor that provides many versatile functions.

GNU Emacs, and other related software, is available from:

Free Software Foundation, Inc.
675 Massachusetts Avenue
Cambridge, MA 02139-3309
USA

+1-617-876-3296

gnu@prep.ai.mit.edu

You can also get information on Emacs from GNU Emacs: UNIX Text Editing
and Programming, Addison-Wesley, 1992.

You can use other third-party editors and desktop publishing systems, such as

WordPerfect R
, Interleaf R
, FrameMaker R
, and IslandWrite R
.
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Starting Text Editor

The Front Panel.

File Manager.

A terminal window.

The Text Editor window provides basic editing.

From the Front Panel

Choose the Text Editor control in the Front Panel.

Start Text Editor by choosing its control.

From File Manager

Double-click a text �le icon.

Or, drag a text �le icon and drop it on the Text Editor control in the Front

Panel.
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From a Terminal Window

Type the following after a command line prompt:

vuepad �lename &

For example:

vuepad myfile & �Enter�

The �le name is optional.
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Typing Text

Start typing. As you type, each character is inserted at the current cursor

position.

To start a new line, press �Enter�.

To start a paragraph, press �Enter� twice.

To avoid pressing �Enter� at the end of each line, use the word wrap feature

described in \Turning Word Wrap On and O�".

As you enter text, a text cursor (I) shows your current position. If you move

the mouse pointer out of the Text Editor window, a marker (^) shows where you
last edited, inserted, or selected text.

New documents you create are titled Text Editor - (unnamed). You give

the document a title when you save it. To save your document, see \Saving

Documents". To edit your document, see \Editing Text".

Example

You can insert text in the middle of existing lines. Simply click where you want

the text to appear, then type. The text cursor (I) shows the insertion point.

The I cursor shows the insertion point.

If you move the mouse pointer out of the Text Editor window, a marker (^)
appears to show where text was last added.
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The ^ indicates the last text added.

Turning Word Wrap On and O�

Choose \Word Wrap" from the Edit menu.

When word wrap is on, the words you type \wrap" onto the next line when you

get close to the right margin.

Using word wrap also a�ects how you save your document. When saving, you

can:

Add a newline character to the end of each word-wrapped line, or

Preserve only line breaks that were created by pressing �Enter�.

You may want to add newlines if you plan to print this document outside of Text

Editor.
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Opening Documents

If you want to edit an existing �le, you must �rst open the �le. Its contents are

displayed in the tablet area.

Opening an Existing Document from Text Editor

The Open File dialog lists �les and directories on your system. You can browse

the lists to locate a �le.

Use the Open File dialog to locate a �le.

1. Choose \Open" from the File menu to display a dialog.

2. Enter or select the document name, then choose OK.

You can also open the �le by double-clicking the document name without having

to click OK.
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Opening an Existing Document from File Manager

1. Display the �le icon for the document in a File Manager window.

2. Double-click the �le icon.

Other ways to open a �le for editing:

Select the document, then choose \Edit" from the Actions menu.

Or, drag the document to the tablet.

Or, drag the document to the Text Editor control in the Front Panel.
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Saving Documents

After editing a document, you need to save it so your changes will be there the

next time you open the document. You can save your changes to the original

�le, or to a new �le.

Caution While you work in a �le, save your changes frequently (every

5 to 10 minutes). Regular saving helps you avoid losing your

changes if there is a power failure or other accident.

Saving Changes to the Original File

Choose \Save" from the File menu.

Your edited document is automatically saved to its original �le. If you used word

wrap, you will be asked whether or not to add newline characters to the end

of word-wrapped lines. You may want to add newlines if you plan to print this

document outside of Text Editor.

Saving to a New File

You can save the current version of the �le under a di�erent name while still

keeping the original �le. This allows you to save a \snapshot" or copy of the �le

before making more changes.

1. Choose \Save As" from the File menu to display the Save As dialog.

Use the Save As dialog to save a new �le.

2. If you used word wrap, choose whether or not to add newline characters to

the end of word-wrapped lines. You may want to add newlines if you plan to

print this document outside of Text Editor.

3. Type the complete �le name in the \Save File As" �eld. See the note below.
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4. Choose OK.

To save the �le in a directory other than the one shown in the \Save File As"

line, backspace over the contents of the line, then type the full �le path name
(for example, /home/anna/projects/manual).

You can use shortcuts for typing the �le path name. See \The Hierarchical File

System" in Chapter 5.

Note When you choose a �le name, keep these rules in mind:

Normally, �le names can contain up to 256 characters, which

can be any combination of the following:

All uppercase and lowercase letters (A through Z; a through z)

Digits (0 through 9)

Special characters, such as +, -, , .

According to these rules, the following are valid �le names:

money Acct.05.93 CODE.c
lost+found 112.3-data foo_bar

File names are case-sensitive. Thus, these �le names are all

di�erent:

money Money moneY MONEY
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Exiting Text Editor

1. Save the open document. See \Saving Documents".

2. Choose \Exit" from the File menu.
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Moving Around in a Document

Moving the Cursor

Point to the new location in the tablet and click mouse button 1.

Or, use the cursor movement keys:

Key . . . Cursor Movement . . .

��� Up one line.

�	� Down one line.

��� Left one character.

��� Right one character.

�CTRL�+��� Right one word.

�CTRL�+��� Left one word.

�CTRL�+�	� Beginning of the next paragraph.

�CTRL�+��� Beginning of the previous paragraph.

��� or �Home� Beginning of the current line.

�f7� End of the current line.

�CTRL�+��� or �CTRL�+�Home� Beginning of the document.

�CTRL�+�f7� End of the document.

Scrolling a Document

Scrolling allows you to see parts of a document that don't �t on the screen.
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Scroll to see the rest of the document.

Use the scroll bars in the window.

Or, use the scrolling keys:

Key . . . Scroll Movement . . .

�Prev� or �Pg Up� Up one page.

�Next� or �Pg Dn� Down one page.

�CTRL� �Prev� or �CTRL� �Pg Up� Left one page.

�CTRL� �Next� or �CTRL� �Pg Dn� Right one page.
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Editing Text

Before you can use the editing commands in this section, such as move, copy,

delete, or clear, you must select the text to be edited, as described in the next

section.

While you're editing a �le, be sure to save your changes frequently (every 5 to

10 minutes). See \Saving Documents".

Selected text appears highlighted.

If you make a change you don't want to keep, you can reverse it by choosing

\Undo" from the Edit menu.

\Undo" reverses the last cut, paste, clear, delete, replace, include, or format

operation.

Selecting Text with the Mouse

Text block:
1. Move the cursor to the beginning of the text block.

2. Hold down mouse button 1 and drag the cursor to the end of the text

block.

To change the amount of selected text, hold down �Shift� and mouse button 1

as you drag the cursor to the new ending point for the selection.

To unselect text, click any empty area in the window.

Word: Double-click the word.

Line: Triple-click the line.

All text: Quadruple-click the tablet.
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Selecting Text with the Keyboard

Text block:
1. Move the cursor to the beginning of the text block.

2. Hold down �Shift� plus an arrow key to move the cursor to the end of the

text block.

All text: Press �Shift�+�CTRL�+�/�.

Moving Text

To move text, you \cut" it from one location and \paste" it in another.

1. Select the text to be moved.

2. Choose \Cut" from the Edit menu. The text is erased from the tablet and

stored temporarily.

3. Move the cursor to the new location.

4. Choose \Paste" from the Edit menu.

When you cut text, it is stored temporarily in a bu�er. This bu�er can hold only

one item at a time. If you cut another piece of text before pasting the �rst

piece, the second piece of text will overwrite the �rst in the bu�er.

Copying Text

1. Select the text to be copied.

2. Choose \Copy" from the Edit menu. A copy of the text is stored temporarily.

3. Move the cursor to the new location.

4. Choose \Paste" from the Edit menu.

Deleting Text

To delete text:

1. Select the text to be deleted.

2. Choose \Delete" from the Edit menu.

If you delete text accidentally, you can recover it with the \Undo" command.

You cannot use \Paste" in the Edit menu to restore deleted text.

Use these keys for simple deletions:

Key Action
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�Backspace� Deletes the character before the cursor.

�Delete char� or �Del� Deletes the character following the insertion cursor.

�CTRL�+�Delete char� Deletes all the characters from the cursor to the end of the

current line.

�Delete line� Deletes the line containing the cursor.

Replacing Text

1. Select the text to be replaced.

2. Type the replacement text.

Clearing Text

Use \Clear" to replace a text block with blank space.

1. Select the text to be cleared.

2. Choose \Clear" from the Edit menu.

Or, press �Clear display�.

If you clear text accidentally, you can recover it with the Undo command.

You cannot use \Paste" in the Edit menu to restore cleared text.
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Finding Text

You may want to �nd a particular word or phrase in a document.

1. Choose \Find" from the Search menu to open the Find dialog.

Use the Find dialog to �nd text.

2. Type the text to �nd in the \Find" �eld. The search is case-sensitive.

3. Choose \Find" to locate the �rst occurrence of the text.

4. To �nd additional occurrences:

Choose \Find" again.

Or, choose \Next" from the Search menu. As a shortcut for the \Next"

command, press �f3�.

\Find" starts at the current cursor position and continues through the entire

document. When it reaches the end of the document, it wraps around to the

beginning.
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Replacing Text

After �nding a word or phrase, you may want to replace the text with a

di�erent word or phrase.

1. Choose \Replace" from the Search menu to open the Replace dialog.

Use the Replace dialog to replace text.

2. Type the text to locate in the \Find" �eld. The search is case-sensitive.

3. Type the replacement text in the \Replace With" �eld.

4. Choose \Find" to locate an occurrence of the text.

5. To replace just that occurrence, choose \Replace".

6. To replace all occurrences in the �le, choose \Replace All".

\Replace" starts at the current cursor position and continues through the entire

document. When it reaches the end of the document, it wraps around to the

beginning.
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Correcting Misspelled Words

Text Editor provides an easy way to �nd and correct any misspellings or

typographic errors.

1. Choose \Spell" from the Search menu. The Spell dialog lists all misspelled or

unrecognized words.

Correct misspelled words with the Spell dialog.

2. Select the word in the \Misspelled Word" list. The selected word

automatically appears in the \Find" �eld.

3. Choose \Find" to locate the word in the document.

4. Type the correct word into the \Replace With" �eld.

5. To replace just that occurrence, choose \Replace". To replace all occurrences

in the �le, choose \Replace All".

Note The Spell dialog is available only for English.
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Including a File in a Document

You can insert a previously-written document into the document you're

currently working on.

The Include File dialog lists �les and directories on your system. You can browse

the lists to locate a �le.

1. Position the cursor where you want to insert the document.

2. Choose \Include" from the File menu to open a dialog.

Use the Include File dialog to include a �le.

3. Enter or select the document name.

4. Choose OK.

You can also include the �le by double-clicking the document name.
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Dragging a File from File Manager

You can use the mouse to drag a �le that you want to include.

1. Open a File Manager window displaying the �le you want to include.

2. Position the text insertion cursor in the document where you want the �le

inserted.

3. Hold down �CTRL� and mouse button 1 as you drag the �le from the File

Manager to the Text Editor tablet.

4. Release the mouse button, then release �CTRL�.
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Using Special Characters in your Text

Occasionally you may need to use control characters or special characters in

your text.

You may want to use two kinds of control characters:

Special instructional characters, such as the form feed character that forces a

form feed when printing.

Special language characters, such as the umlaut used in German text.

1. Position the cursor in the text where you want the special character.

2. Type �CTRL�+�Q�, then the special character.

Example

To insert a form feed character into your document:

1. Position the cursor.

2. Type �CTRL�+�Q�, then �CTRL�+�L�.

Note �CTRL�+�Q� has no e�ect on key sequences used in Text Editor as

menu mnemonics or accelerators.

The following English key sequences are used as mnemonics and

accelerators and cannot be changed.

�Alt�+�E�, �Alt�+�F�, �Alt�+�H�, �Alt�+�R�, and �Alt�+�S�.
�CTRL�+�F�.

6-22 Editing Files Part I: Using HP VUE



Formatting Documents

Once your editing is complete, format your document by choosing margins and

justi�cations.

1. Choose \Settings" from the Format menu to open a dialog.

Choose format settings in the Settings dialog.

2. Enter margins and select justi�cations.

3. Do one of the following:

To format a paragraph, place the cursor in the paragraph, then choose

\Paragraph".

To format the entire document, choose \All".

To reuse the margin and justi�cation settings after the dialog box is closed,

choose \Paragraph" or \All" from the Format menu.

Note The \Center" option is not available in Japanese, Chinese, or

Korean.
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Printing Documents

After editing and formatting your document, you can print it.

1. Open the document in Text Editor.

2. Choose \Print" from the File menu.

The document prints on your default printer.

For more information on printing, see Chapter 10.
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7

Using Electronic Mail

With an electronic mailer program, you can send and receive messages over

a network. You can communicate quickly anywhere within your company,

country, or the world.

If you are on a multi-user system, you can send mail messages to other users on

your system. If your system is con�gured to a network, such as a local area

network (LAN), you can send mail messages to users on other systems.

If you are connected to a larger network such as the Internet, you can

communicate with users worldwide. Consult your system administrator to

determine where you can send electronic mail.
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Starting the elm Mailer

Note If you have purchased the optional MPower product, your

default mailer is still elm but it will behave somewhat

di�erently. If you have purchased the optional Ready-to-Wear

product, you will have a di�erent mailer instead of elm. For
information, see the appropriate User's Guide.

The default mailer program in your HP VUE front panel is called elm (the

electronic mailer). You can also use the mailx mailer or other, third-party,

mailer programs.

1. To start a window displaying the elm mailer, choose the Mailer control.

The Mailer control starts the elm mailer.

If you have new messages, the Mailer control looks like this:

Multiple envelopes indicate new messages.

2. If this is the �rst time you have started elm, you will be asked two questions

about creating directories and folders. Answer y (yes) to both.

3. To get help in elm, press �?� at the command prompt.

a. For a summary of all of the commands you can use from elm, press �?�
again.
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b. For help on a particular command, type the �rst letter of the command

(for example, press �R� to get information about the reply command).

To change the default mailer, see Chapter 18 in the HP Visual User
Environment 3.0 User's Guide. Or, see HP VUE's online help. Click the Help

Manager control, then click "HP Visual User Environment Version 3.0 Help",
then click \General Con�guration", then click \Terminal, Mailer, Editor, and

Printer Con�guration", then click \Changing the Default Terminal, Editor, and

Mailer".
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Understanding the Main Screen

The main screen of elm has several components, shown in the following

illustration.

The elm mailer lets you send and receive messages.

The main screen has these elements:

Heading The �rst line on the screen displays the current mailbox, the

number of messages, and the current elm revision number.

Date The date when the message was sent.

Message sender The mail address of the person who sent the message.

Number of lines The total number of lines in the message.

Subject of message A description of the contents of the message.

Current message

pointer

The highlight indicates the current message.
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Status �eld The status or characteristics of each message. The �eld

can be blank, or contain the following common status

characters:

N|new message

NU|new urgent message

D|message is to be deleted

Message number This is used to specify a message.

Menu This three-line menu at the bottom of the screen shows the

commands available.

Command prompt In response to the \Command:" prompt, type any of the

commands in the menu.

Softkeys You can use these softkeys instead of the letter keys to

execute commands in the menu.
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Entering elm Commands

Even if you are not familiar with mailers, you can easily use elm by following

the instructions displayed on each screen.

To enter an elm command, type the �rst letter (uppercase or lowercase) of the

command. Commands in elm are not case-sensitive.

Or, press the softkey (
NNNNNNNN
f1 through

NNNNNNNN
f8 ) corresponding to the command you

want to enter.

Note If softkeys aren't already displayed, you can turn them on with

this procedure:

1. Edit the �le called elmrc in the /HomeDirectory/.elm
directory.

2. Search for the line that begins with softkeys.

3. Change it to read softkeys=ON.

For a summary of elm commands, press �?� within elm, then press �?� again.

Also see \Elm Command Summary" at the end of this chapter.
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Reading Your Mail

To read your mail, start elm by choosing the Mailer control in the Front Panel.

If new mail has arrived, the Mailer control shows multiple envelopes.

If you have mail, elm displays a list of mail messages. You can read the current

message or pick a speci�c message to read. Messages appear in a display similar

to the following:

Elm lists your mail messages.

To read the current (highlighted) message, press �Enter�.

(You can con�gure elm to use a > to indicate the current message. See

\Customizing elm".)

To advance to the next message, press �	�.

To move to the previous one, press ���.

To jump to a speci�c message in the header, type the number of the message

and press �Enter�.

Caution Problems with system behavior may result if you attempt to use

one of the other HP-UX mailers, such as mailx, while you are

also working in elm.

This example shows the output from reading message 1.
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An example message.

To return to the elm main screen, press �Enter�.

Only ten message headers appear on the screen at one time. If you have more

than ten messages you can display them as follows:

To see the next page of message headers, press �+�.

To see the previous page, press �-�.

To move to the �rst message in the list, press �=�.

To move to the last message in the list, press �*�.
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Sending Mail to Users on Your System

One of the easiest ways to learn how to send a mail message is to send one to

yourself.

1. Start elm by choosing the Mailer control in the Front Panel.

2. To mail a message, press �M� as the response to \Command:"

Command: m

3. elm responds with a prompt requesting the mail address of the recipient.

(To use aliases for recipients, see \Using Mail Aliases".)

On your local system, your mail address is the same as your user name.

Type your user name and press �Enter�. For example:

Send the message to: leslie

To send a message to more than one person, simply specify each recipient's

name.

Send the message to: mike leslie tj

4. elm then responds with a subject line prompt. Type the subject line of the

message and press �Enter�. For example:

Subject of Message: Important Message to Myself

5. elm responds with a prompt for the carbon copies. Type the mail addresses

of any users who should receive a carbon copy of the message, then press

�Enter�.

In this example, since you're sending a message to yourself, you don't want

to send any additional copies so press �Enter�.

6. elm brings up an editor window. Type the message. For information about

using Text Editor, see Chapter 6. For information about using vi, see
Chapter 17.

This screen shows a sample message.

Part I: Using HP VUE Using Electronic Mail 7-9



An example message.

To con�gure your workstation to bring up a di�erent editor, see \Customizing

elm".

7. When you are done typing, save the message.

8. After you exit the editor, you will see the following message on the screen.

Please choose one of the following options by the first character:
E)dit message, edit the H)eaders, S)end it, or F)orget it. s

9. To change any of the header information for your message (for example,

to add recipients to the Cc list, change the message subject, or mark the

message as Urgent), press �H�.

10. To send your message, type s

11. After you have sent the mail message, the elm main screen reappears and

displays the message \Mail sent!". It might take a few seconds for the

system to deliver the message.
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Sending Mail to Users on Other Systems

If your system is connected to other systems over a LAN (local area network) or

other networking facility that supports elm, you can also send mail to users on

other systems.

Host Names

Every workstation connected over a network has a unique host name (also
known as a node name). To send mail to a user on another workstation, you

must know the host name of the user's workstation.

This �gure shows an example LAN with four workstations connected. The host

names are research, market, develop, and sell.

Example host names on a network.

The host name of your own workstation is displayed in any File Manager or

Toolbox window.

The host name is circled.
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Mail Syntax when Mailing to Other Systems

The general syntax used when mailing to a user on another workstation is

either:

user@host simple format

user@host.organization.domain Domain naming

host is the host name of the workstation the person is on, and user is the
person's unique user name.

If the user you are sending to is at another organization, the syntax may also

include that person's organization name (such as ucsd or hp), and the domain
to which the organization belongs (such as edu for educational institutions, and

com for commercial businesses).

Your system administrator can tell you which syntax to use.

Examples

Suppose you want to send mail to user john, who uses the workstation named

sell. Then, in response to the elm prompt, you would type the following:

john@sell

To send mail to arnie on your workstation, john on the sell workstation, and

leopold on the research workstation, use the following addresses:

arnie john@sell leopold@research

To send mail to mark who works for a university and davidm who works for the

XYZ company, use the following addresses:

mark@hub.ucsd.edu davidm@xyz.com

In the �rst part of this example, mark is the user name, hub is the hostname of

Mark's workstation, ucsd is the abbreviation for \University of California at San

Diego", and edu is the domain name for educational institutions. In the second

part, davidm is the user name, xyz is the abbreviation for the XYZ Company,

and com is the domain name for companies and businesses.
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Using Mail Aliases

You can set mail aliases for people you mail to frequently. Aliases are shortcuts

that you de�ne so you don't have to type a recipient's complete mail address.

elm provides two types of aliases:

User alias For private use. Individual users create and maintain their own

user aliases. To create user aliases, see \Creating Mail Aliases".

System alias For use by all users with the same host. The system

administrator must create and maintain the system aliases.

Understanding Mail Aliases

Aliases allow you to send messages to several recipients by specifying a single

name, or to send messages without specifying a complete mail address.

For example, for Christine Lawson at mail address christine@market.elm.com
you might create the alias chris. To send a message to Christine, you could

enter her alias at the To: prompt:

To: chris

elm automatically converts it to the proper address and full name:

To: christine@market.elm.com (Christine Lawson)

Here are more example aliases. (These aliases are shown in the format that elm
uses to store them in the /HomeDirectory/.elm/aliases.text �le. This �le is

automatically appended to when you create aliases.)

writers = My writing group = john jtl michele ken willa bg
friends = David and Mark = davidm@xyz.com mark@hub.ucsd.edu
tom = Tom Middleton = tmm@eff.org

Thus, sending a message to writers means that john, jtl, michele, ken,
willa, and bg on the local system all receive the message. Sending a message

to friends means that davidm@xyz.com and mark@hub.ucsd.edu receive the

message. Sending a message to tom is shorthand for sending to tmm@eff.org.
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Creating Mail Aliases

1. Press �A� in response to the \Command:" prompt on the elm screen. The

\Alias commands" sub-menu appears.

2. Press �M� at the \Alias:" prompt to make a new alias.

Note To make an alias for the person who sent the current message,

use a instead of m. This command reads in the sender's address

automatically in step 5.

3. Enter the desired alias name, and press �Enter�. For example:

Enter alias name: chris �Enter�

You can set more than one alias name. For example, if you enter chris and

cl in the example under \Understanding Mail Aliases", you can use either

alias to send mail to Christine Lawson.

4. Enter the full name at the next prompt, and press �Enter�.

For example:

Full name for chris: Christine Lawson �Enter�

5. Enter the address in response to the next prompt, and press �Enter�.

For example:

Enter address for chris: christine@market.elm.com �Enter�

Then the sub-menu \Alias commands" returns.

6. Press �Enter� to set the alias. The main screen returns.

Note To create an alias for a group of users, enter more than one

address. For example, if you set:

In step 3 Enter alias name: friends
In step 4 Full name for friends: Incredible Three
In step 5 Enter address for friends: chris, john,

alex@market

You can send a message to chris, john, and alex by

responding to the \To:" prompt with:

To: friends �Enter�
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Note that you must make the aliases chris and john before

making the group alias. If aliases have not been made, you must

enter the user's full address, as is done with alex@market.

Listing and Deleting Aliases

You can view your aliases and delete those you no longer need.

1. Press �A� in response to the \Command:" prompt on the elm screen. The

\Alias commands" sub-menu appears.

2. To check the address of a speci�c alias, press �P� and enter the alias name.

3. To list user aliases, press �U�.

4. To list system aliases, press �S�.

5. To delete a speci�c alias, press �D� and enter the alias name.

6. To return to elm's main screen, press �R� or press �Enter�.
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Replying to Messages

When you receive a message, you may want to reply to it right away.

1. Move the message pointer to highlight the message to which you want to

reply.

2. To reply to just the sender of the message, press �R�.

Or, to reply to everyone who received the message, press �G�.

The following message appears at the bottom of the screen.

Command: Reply to message Copy message (y/n)? n

(If you pressed �G�, \Group reply" appears after \Command:".)

3. Press �Enter� if you don't need to include the original message in your reply.

Press �Y� if you do need to include it.

4. The bottom part of the screen now appears similar to this:

Command: Reply to message To: charlie (Charlie Pike)

Subject of message: Re: Meeting Schedule Changed!

The \To:" and \Subject of message:" �elds are automatically �lled in. The

\Re:" in front of the subject indicates that the message is a reply.

If the message you are replying to has no subject,

\Re: your mail" is used in the subject �eld.

You can change the subject �eld by backspacing over it and typing a new

subject.

5. elm responds with a prompt for the carbon copies.

Type the mail addresses of any users who should receive a carbon copy of

the message, then press �Enter�.

6. elm brings up an editor window.

If you chose yes in reply to the \Copy message" prompt, the editor will be

invoked with the original message copied into the editing bu�er. elm inserts

the default pre�x character (>) and a blank at the beginning of each line of

the copied message.

Type an introductory message.
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For help with using Text Editor, see Chapter 6. For help with using vi, see
Chapter 17.

To con�gure your workstation to bring up a di�erent editor, see

\Customizing elm".

7. When you are done typing, save the �le.

8. After you exit the editor, you will see the following message on the screen.

Please choose one of the following options by the first character:
E)dit message, edit the H)eaders, S)end it, or F)orget it. s

9. To change any of the header information for your message (for example,

to add recipients to the Cc list, change the message subject, or mark the

message as Urgent), press �H�.

10. To send your message, type s

11. After you have sent the mail message, the elm main screen reappears and

displays the message \Mail sent!".
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Forwarding Messages

You may receive messages that you want to forward to someone else, with or

without adding your own comments.

1. Move the message pointer to the message you want to forward.

2. Press �F�. The following message appears at the bottom of the screen.

Command: Forward Edit outgoing message (y/n)? y

3. Press �N� if you don't want to edit the forwarded message.

Press �Enter� if you do want to edit it.

4. The bottom part of the screen changes to:

Command: Forward Edit outgoing message (y/n)? Yes

Send the message to:

5. Enter the mail address of the person you want to forward the message to.

To use aliases for recipient names, see \Using Mail Aliases".

For example, if you enter donesky,

Command: Forward To: donesky

Subject of message: AI Competition (fwd)

\(fwd)" is attached to the subject automatically. It tells the recipient that

this is a forwarded message.

If the message you are forwarding has no subject, \Forwarded mail" is used

in the subject of message �eld. The subject �eld can be edited.

6. elm responds with a prompt for the carbon copies.

Type the user addresses of any users who should receive a carbon copy of

the message, then press �Enter�.

7. elm brings up an editor window.

If you chose yes in reply to the \Edit outgoing message" prompt, the editor

will be invoked with the original message copied into the editing bu�er. elm
inserts the default pre�x character (>) and a blank at the beginning of each

line of the copied message.

8. Type an introductory message.
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For information about using Text Editor, see Chapter 6. For information

about using vi, see Chapter 17.

9. When you are done typing, save your �le.

10. After you exit the editor, you will see the following message on the screen.

Please choose one of the following options by the first character:
E)dit message, edit the H)eaders, S)end it, or F)orget it. s

11. To change any of the header information for your message (for example,

to add recipients to the Cc list, change the message subject, or mark the

message as Urgent), press �H�.

12. To send your message, type s

13. After you have sent the mail message, the elm main screen reappears and

displays the message \Mail sent!".

Part I: Using HP VUE Using Electronic Mail 7-19



Saving Messages to a File

You may want to save important messages for future reference.

1. To save the current message to a �le, at the \Command:" prompt, type:

Command: s

2. The following prompt appears:

Command: Save Message

File message in: =/username

If you press �Enter�, the message is saved in a �le named with the sender's

username in the Mail directory in your home directory.

The equal sign (=) is shorthand for /HomeDirectory/Mail.

To save the message in another �le, enter the name of the �le (the name

you enter replaces =/username). For example:

Command: Save Message
File message in: =/oldnews

If the user is Leslie, the current message is saved in the �le oldnews in

the /home/leslie/Mail directory. If the oldnews �le already exists, the

message will be appended to the contents of the �le. If the oldnews �le

doesn't already exist, it will be created.

3. To save the message in another directory, enter the path name of the
directory and the name of the �le.

For example:

Command: Save Message
File message in: ~/messages/oldnews

If the user is Leslie, the current message is saved in the �le oldnews in the

/home/leslie/messages directory. If the �le already exists, the message will

be appended to the contents of the �le. If the oldnews �le doesn't already

exist, it will be created.

The
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Mail Directry softkey is shorthand for the directory

/HomeDirectory/Mail. The
NNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNNN
Home Directry softkey is shorthand for

/HomeDirectory/.
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Caution After you save a message in a �le, the message is marked with a

D for deletion. When you exit elm, the message is automatically
deleted.
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Deleting Mail Messages

After you have read your mail messages, you may want to delete them.

1. To delete a mail message, highlight the message and press �D�.

A D appears to the left of the message to show that it is marked for deletion.

2. To move to the next message, use the arrow keys, �	� and ���.

3. Delete the marked messages at the \Command:" prompt in one of two ways:

a. To delete the marked messages and quit elm, press �Q�. elm will ask you

to con�rm this action.

b. To delete the marked messages without quitting elm, press �$�.

The following screen shows two messages marked for deletion:

Messages are marked with a \D" for deletion.
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Exiting the elm mailer

When you are in elm, exit by typing �Q� at the \Command:" prompt.

If you have mail, elm responds as follows:

Command: q Keep mail in incoming mailbox ? (y/n) y

If you press �Y� or press �Enter�, any messages in the incoming mailbox will

remain there. You will see these messages when you start elm again.

If you press �N�, messages are stored in your home directory in an alternate

mailbox, called mbox.
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Mailing a Directory and Contents

Sometimes you may need to mail multiple �les to another user. You can use

the HP-UX shar utility to bundle �les and directories into a single distribution

package. You can then use elm to mail the package.

The �les can contain any type of data, including executable programs that

otherwise cannot be mailed. The resulting package can be edited, for example,

to add a message at the beginning.

The optional MPower product allows you to send audio, video, and fax messages

through electronic mail.

1. To bundle �les, type the following command in a terminal window:

shar �lename > packagename

You can use more than one �lename, separated by spaces. The output of

shar appears only on your screen unless you redirect the output with >
packagename.

For example, to archive all �les with a .tag su�x in the current directory in

a �le called myarchive, type:

shar *.tag > myarchive �Enter�

The asterisk * is a \wildcard" that matches any combination of characters.

2. To unpack a shar package:

a. Edit the �le and delete any mail headers or messages at the top of the �le.

b. Use the sh command with the package name as follows:

sh package

When unpacking, the �les and directories in the package are written to

their original directory path names.

Using Options for Packing Files

You can also use options with the shar command. For example, in this

command:

shar -CvZ *.tag > myarchive �Enter�

The -C option adds a line saying --- cut here --- before the archive. The -v
option lists the �le names as they are packaged. The -Z option compresses the
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�les so that they require less disk space. For more information on shar options,

see shar(1) in the HP-UX Reference.

To pack �les from many directories and unpack them into one directory, use the

-b option. The original path names are ignored.

For example, the following command packs �les from two directories:

shar -b /home/leslie/list /home/leslie/pics/pic.xwd > package �Enter�

When package is unpacked, list and pic.xwd are placed in the current

directory. Without -b, the original directories would be recreated during

unpacking.

Mailing a Package

1. Start elm by choosing the Mailer control in the Front Panel.

2. Press �M� to mail a message.

3. Respond to the prompts for recipient, subject, and copies.

4. When the editor window opens, read in the package �le.

In Text Editor, choose \Include" from the File menu. Or, in vi, press �ESC�,
then type :r �lename.

5. Type an introductory message, if desired.

6. When you are done typing, save your �le.

7. After you exit the editor, you will see the following message on the screen.

Please choose one of the following options by the first character:
E)dit message, edit the H)eaders, S)end it, or F)orget it. s

8. To change any of the header information for your message (for example,

to add recipients to the Cc list, change the message subject, or mark the

message as Urgent), press �H�.

9. To send your message, type s

10. After you have sent the mail message, the elm main screen reappears and

displays the message \Mail sent!".
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Customizing elm

The elm mailer has di�erent options you can set to make it more convenient

for you to use. Among features you can change are the menus that appear on

the screen, the printer your mail is sent to, and the order in which your mail is

listed in your mailbox. These are entered automatically in the .elm/elmrc �le.

This �le is created by elm and contains your default settings and customizations.

Using the Options Editor

To start the elm options editor, press �O� at the elm command prompt:

Command: o

You will see a screen similar to the following:

You can con�gure elm using the options editor.

Using the screen, you can change the 12 prede�ned settings in the .elm/elmrc
�le. For information on changing other settings, see Mail Systems: User's Guide.

1. To select an option to set, type the �rst letter of the option. For example, to

change the way messages are sorted, press �S�.

7-26 Using Electronic Mail Part I: Using HP VUE



Index

A

absolute path name, 5-5

access permissions, 5-8

changing in File Manager, 5-20

example of changing, 5-8

account, user

creating in HP VUE, 1-14

action

double-clicking, 5-13

executing action of directory, 5-21

executing action of �le, 5-21

executing action of object, 5-21

Actions menu, 5-13

active window, 3-2

address

IP, 1-3

mail, 7-12

alias

creating, 7-14

deleting, 7-15

elm mailer, 7-13

listing, 7-15

system alias in elm, 7-13
user alias in elm, 7-13

�Alt�, 3-2
annotating �les, 5-3

application

exiting, 3-3

getting help, 4-5

help menu, 4-2

starting in terminal window, 3-34

application window

opening and closing, 3-3

using controls in, 3-21

archive

creating for mailing, 7-24

audio

annotation, 5-3

B

basic �le management skills, 5-10

basic window skills, 3-1

books available, 1-23

ordering, 1-23

booting your workstation, 1-5

browsing help, 4-2, 4-12

button

choosing, 3-26

mouse, 1-8

C

canceling

dragging, 5-13

session, 1-18

changing

directory in File Manager, 5-21

File Manager default preferences,

5-31

File Manager sort order, 5-30

File Manager view , 5-30

File Manager view style, 5-31

host name, 1-22

IP address, 1-22

mailer, 7-3

Index-1



order of overlapping windows, 3-7

owner of directory in File Manager,

5-19

owner of �le in File Manager, 5-19

properties of directory in File

Manager, 5-19, 5-20

properties of �le in File Manager,

5-19, 5-20

properties of object in File Manager,

5-19, 5-20

time zone, 1-22

window into icon, 3-4

checking spelling

in Text Editor, 6-19

choosing

between current and home session,

2-17

button, 3-26

control from subpanel, 3-16

from the window menu, 3-13

from the Workspace menu, 3-13

Front Panel control, 3-15

list item, 3-24

object, 1-9

startup procedure, 1-2

Clean Up (command in View menu),

5-30

clearing text in Text Editor, 6-16

clicking, 1-9

clipboard, 3-23

closing

application window, 3-3

terminal window, 3-31, 3-33

Text Editor, 6-11

window, 3-3

cluster node, 1-3

commands

elm, 7-6
commands (by name)

elm, 7-1
ln -s, 5-18

shar, 7-24
vuepad, 6-4

con�guring

elm mailer, 7-26

set_parms program, 1-22

contents

�nding �le by, 5-29

context-sensitive help, 4-2, 4-6

control

choosing from subpanel, 3-16

Front Panel, 2-7, 3-15

Terminal, 3-31

using in application window, 3-21

control characters, using in Text

Editor, 6-22

control panel

contents, 2-7

using, 3-15

conventions, typographic, vi

copying

directory in File Manager, 5-17

�le in File Manager, 5-17

�le in HP VUE Lite, 5-18

object in File Manager, 5-17

text in Text Editor, 6-15

creating

directory in File Manager, 5-16

document in Text Editor, 6-5

�le in File Manager, 5-16

mail aliases, 7-14

object in File Manager, 5-16

symbolic link in File Manager, 5-18

user account in HP VUE, 1-14

current and home session

choosing between, 2-17

current message, 7-7

current session de�ned, 2-16

cursor

moving in document, 6-12

shapes, 1-8

customizing
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elm mailer, 7-26

File Manager , 5-30

cutting

text from windows, 3-23

text in Text Editor, 6-15

D

default

mailer, 7-3

network gateway, 1-4

saving File Manager current

preferences as, 5-31

de�ning

mail aliases, 7-14

de�nition

directory, 5-5

�le, 5-5

path, 5-5

de�nition hyperlink, 4-8

deleting

directory using Trash Can, 5-22

�le using Trash Can, 5-22

mail messages, 7-22

object using Trash Can, 5-22

text in Text Editor, 6-15

using Trash Can, 5-22

Desktop

HP-UX version, 1-6

HP VUE, 5-4

putting �le or directory on, 5-25

removing �le or directory from,

5-27

removing object from, 5-27

using, 5-25

Desktop HP-UX, 1-6

dialog box

Host, 3-36

directory

changing in File Manager, 5-21

changing owner in File Manager,

5-8, 5-19

changing properties in File Manager,

5-19, 5-20

changing who has access to, 5-8

copying in File Manager, 5-17

creating in File Manager, 5-16

deleting in HP VUE Lite, 5-23

deleting using Trash Can, 5-22

dropping, 5-13

getting help on, 5-12

hidden, 5-31

hiding, 5-32

mailing, 7-24

moving in File Manager, 5-16

navigating in File Manager, 5-21

opening in File Manager, 5-13

ownership, 5-8

parent, 5-6

permissions, 5-8

protecting, 5-8

protecting in File Manager, 5-20

putting on Desktop, 5-25

removing from Desktop, 5-27

removing using Trash Can, 5-22

renaming in File Manager, 5-12

re-sorting directories, 5-30

restoring from Trash Can, 5-23

security, 5-8

selecting multiple directories, 5-11

selecting single, 5-10

displaying

another workspace, 3-18

�le permissions in File Manager,

5-20

man pages, 4-15

subpanel, 3-16

display lock, 2-19

display, locking and unlocking, 2-19

DNS name server, 1-4

document

creating in Text Editor, 6-5

editing in Text Editor, 6-1, 6-14
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formatting in Text Editor, 6-23

including a �le in Text Editor, 6-20

opening from File Manager, 6-8

opening in Text Editor, 6-7

printing in Text Editor, 6-24

saving in Text Editor, 6-9

scrolling in Text Editor, 6-12

documentation

available, 1-23

ordering, 1-23

domain name, 1-4

Domain Name System name server,

1-4

dot �les, 5-31

double-clicking, 1-9

dragging, 1-9

canceling, 5-13

dropping

directory, 5-13

�le, 5-13

object, 5-13

dtterm, 3-30

E

editing

text in �eld, 3-22

text in Text Editor, 6-14

text or document in Text Editor,

6-1

editor

emacs, 6-2
Text Editor, 6-1

third-party, 6-2

electronic mail, 7-1

addresses, 7-12

aliases, 7-13

current message, 7-7

deleting messages, 7-22

forwarding, 7-18

mailing �les, 7-24

reading, 7-7

replying to, 7-16

saving to a �le, 7-20

sending to users on other systems,

7-11

sending to users on your system,

7-9

.elm directory, 7-26

elm mailer, 7-1

aliases, 7-13

commands, 7-6

creating aliases, 7-14

deleting aliases, 7-15

deleting messages, 7-22

exiting, 7-23

forwarding messages, 7-18

getting help, 7-2

listing aliases, 7-15

main screen, 7-4

options, 7-26

packaging �les, 7-24

reading mail, 7-7

replying to messages, 7-16

saving messages, 7-20

sending mail, 7-9, 7-11

starting, 7-2

elmrc �le, 7-26

emacs editor, 6-2

emptying Trash Can, 5-23

ending a session, 1-18

�Enter�, 3-2
entering

text in Text Editor, 6-5

text into empty �eld, 3-22

erasing

using Trash Can, 5-22

errors

System Administration Tasks, 1-24
example

inserting text in Text Editor, 6-5

sending mail, 7-12
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starting application in terminal

window, 3-34

starting terminal windows from

command line, 3-32

execute permission

for �les, 5-8

execute/search permission for

directories, 5-8

executing

action of directory, 5-21

action of �le, 5-21

action of object, 5-21

exiting

application, 3-3

elm, 7-23
Text Editor, 6-11

�Extend char�, 3-2

F

factory-installed software, 1-3

failsafe session

logging in and out, 2-14

starting, 2-13

�eld

editing text in, 3-22

entering text into empty, 3-22

�le

annotation, 5-3

changing owner in File Manager,

5-19

changing properties in File Manager,

5-19, 5-20

copying in File Manager, 5-17

creating in File Manager, 5-16

deleting in HP VUE Lite, 5-23

deleting using Trash Can, 5-22

dropping, 5-13

editing in Text Editor, 6-1, 6-14

�nding by contents, 5-29

�nding by name, 5-28

formatting in Text Editor, 6-23

getting help on, 5-12

hidden, 5-31

hiding, 5-32

including in Text Editor, 6-20

locating with File Manager, 5-28

mailing, 7-24

management, basic skills, 5-10

managing �les, 5-1

moving in File Manager, 5-16

names, 6-10

opening in File Manager, 5-13

opening in Text Editor, 6-7

ownership, 5-8

permissions, 5-8

printing in Text Editor, 6-24

putting on Desktop, 5-25

removing from Desktop, 5-27

removing using Trash Can, 5-22

renaming in File Manager, 5-12

re-sorting �les, 5-30

restoring from Trash Can, 5-23

saving in Text Editor, 6-9

scrolling in Text Editor, 6-12

security, 5-8

selecting multiple �les, 5-11

selecting single, 5-10

File Manager, 5-1

changing sort order, 5-30

changing view style, 5-31

control, 5-10

customizing, 5-30

opening document, 6-8

saving current preferences as

default, 5-31

�le name

guidelines, 6-10

�le permissions

displaying in File Manager, 5-20

�le system, hierarchical, 5-5

�nding

�le by contents, 5-29
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�le by name, 5-28

�le with File Manager, 5-28

text in Text Editor, 6-17

�rst time for starting workstation,

1-2

choosing procedure, 1-2

font

client, 1-5

server, 1-5

formatting document in Text Editor,

6-23

forwarding message, elm mailer, 7-18
frame, window, 3-2

Front Panel

control, choosing, 3-15

controls, 2-7

File Manager control, 5-10

HP VUE Lite, 2-10

icons, 2-7

logout control, 1-18

Mailer control, 7-2

moving, 3-17

regular session, 2-7

Trash control, 5-22

turning into icon, 3-18

using, 2-12, 3-15

G

getting

context-sensitive help, 4-6

help, 4-2

help on directory, 5-12

help on �le, 5-12

help on object, 5-12

help within application, 4-5

group, user, 5-8

guidelines

�le names, 6-10

password, 1-17, 1-21

H

halting your system, 1-20

Soft Powerdown feature, 1-20

hardware

installation, 1-2

self-tests, 1-7

help, 4-2

applications, 4-2

browsing, 4-2, 4-12

context-sensitive, 4-2, 4-6

elm mailer, 7-2

�nding topic by exploring, 4-10

�nding topic by keyword, 4-10

getting help on directory, 5-12

getting help on �le, 5-12

getting help on object, 5-12

getting within application, 4-5

hyperlinks, 4-8

man pages, 4-15

printing help topics, 4-18

requesting, 4-6

searching (keyword index), 4-10

server, 4-2

subpanel, 4-3

topic hierarchy, 4-8

windows, 4-2, 4-5

Help Manager

starting, 4-13

Help menu, 4-6

Help System, HP, 4-2, 4-5

hidden �les, 5-31

hiding

directory, 5-32

�le, 5-32

object, 5-32

hierarchy

�le system, 5-5

online help, 4-8

home and current session, choosing

between, 2-17

home session
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automatically starting at login,

2-17

de�ned, 2-16

saving, 2-16

Host dialog box, 3-36

host name, 1-3, 7-11

HP Help System, 4-2, 4-5

hpterm, 3-30
HP-UX

cluster, 1-3

Desktop version, 1-6

installing, 1-3

manuals, 1-23

runtime version, 1-6

HP-UX Reference manual pages, 4-15

HP VUE

basic skills, 3-1

copying �le, 5-17

creating �le or directory, 5-16

creating user account, 1-14

deleting directory, 5-22

deleting �le, 5-22

�le management, 5-21

installing, 1-3

logging in, 1-11

manuals, 1-23

moving �les, 5-16

starting session, 1-11

terminal window, 3-29

HP VUE Lite

copying �le, 5-18

creating symbolic link, 5-19

deleting directory, 5-23

deleting �le, 5-23

deleting object, 5-23

Front Panel, 2-10

logging in, 1-11

moving �les, 5-17

starting session, 1-11, 2-13

terminal window, 3-35

HP VUE Quick Start Card, 1-23

HP VUE User's Guide, 1-23

hyperlinks, 4-8

I

icon

changing sort order, 5-30

Front Panel, 2-7

selecting multiple icons, 5-11

selecting single, 5-10

turning Front Panel into, 3-18

turning window into, 3-4

iconify window, 3-4

including

�le in Text Editor, 6-20

information about your workstation,

1-23

initial startup, 1-5

inserting

�le in Text Editor, 6-20

installing

guide for, 1-23

hardware, 1-2

Installing HP-UX, 1-23
peripherals, 1-23

software, 1-3

Instant Ignition, 1-3

Internet Protocol address, 1-3

IP address, 1-3

item

choosing list, 3-24

help on, 5-12

J

justi�cation, Text Editor, 6-23

K

keyboard

choosing object, 1-9

selecting, 1-9

keys used to move around in

workspace, 3-9
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keyword, �nding help topic by, 4-10

L

language, non-English, 2-14

leaving

elm, 7-23
Text Editor, 6-11

link, creating symbolic, 5-18

links, online help, 4-8

list item, choosing, 3-24

ln -s command, 5-18

locating

�le with File Manager, 5-28

locking the display, 2-19

logging in

as superuser, 1-12

failsafe session, 2-14

non-English language, 2-14

with HP VUE, 1-11

with HP VUE Lite, 1-11

logging out

failsafe session, 2-14

with HP VUE, 1-18

M

mail, 7-1

addresses, 7-12

aliases, 7-13

current message, 7-7

deleting messages, 7-22

forwarding, 7-18

mailing �les, 7-24

reading, 7-7

replying to, 7-16

saving to a �le, 7-20

sending to users on other systems,

7-11

sending to users on your system,

7-9

mail aliases, 7-13

creating, 7-14

deleting, 7-15

listing, 7-15

mailer

changing default, 7-3

Mailer control

Front Panel, 7-2

mailing �les, 7-24

making

directory in File Manager, 5-16

document in Text Editor, 6-5

�le in File Manager, 5-16

object in File Manager, 5-16

symbolic link in File Manager, 5-18

user account in HP VUE, 1-14

managing

�les, 5-10

man pages, displaying, 4-15

manual reference pages, 4-15

manuals available, 1-23

ordering, 1-23

margins, Text Editor, 6-23

matching wildcards, 5-28

menu

Actions, 5-13

popup, 5-4, 5-14

Terminal, 3-36

using, 3-10

window, 3-12

Workspace, 3-13

messages

forwarding, 7-18

reading, 7-7

replying to, 7-16

saving to a �le, 7-20

sending, 7-9

sending to users on other systems,

7-11

startup, 1-5

minimize window, 3-4

misspelled words

correcting in Text Editor, 6-19
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mouse

buttons, 1-8

choosing object, 1-9

clicking, 1-9

double-clicking, 1-9

dragging, 1-9

pointer, 1-9

selecting, 1-9

using, 1-8

moving

around in workspace using keys,

3-9

between directories in File Manager,

5-21

cursor within document, 6-12

directory in File Manager, 5-16

�le in File Manager, 5-16

�le in HP VUE Lite, 5-17

Front Panel, 3-17

object in File Manager, 5-16

text in Text Editor, 6-15

window or window icon, 3-5

multiple directories, selecting, 5-11

multiple �les, selecting, 5-11

multiple icons, selecting, 5-11

multiple objects, selecting, 5-11

N

name

�le, 6-10

�nding �le by, 5-28

name server, 1-4

Native Language Support, 2-14

navigating

directories and subdirectories in

File Manager, 5-21

navigating with the keyboard, 3-9

Network Information Service domain

name, 1-4

new user account

creating in HP VUE, 1-14

NIS domain name, 1-4

NLS, 2-14

node name, 7-11

non-English HP VUE sessions, 2-14

No Windows mode, 2-14

starting session, 2-13

O

object

changing properties in File Manager,

5-19, 5-20

copying in File Manager, 5-17

creating in File Manager, 5-16

deleting in HP VUE Lite, 5-23

deleting using Trash Can, 5-22

dropping, 5-13

executing its action, 5-21

executing its directory, 5-21

executing its �le, 5-21

getting help on, 5-12

hiding, 5-32

moving in File Manager, 5-16

opening in File Manager, 5-13

putting on Desktop, 5-25

removing from Desktop, 5-27

renaming in File Manager, 5-12

re-sorting objects, 5-30

restoring from Trash Can, 5-23

selecting multiple objects, 5-11

selecting single, 5-10

online help, 4-2

applications, 4-2, 4-5

browsing, 4-2, 4-12

context-sensitive, 4-2, 4-6

elm mailer, 7-2

hyperlinks, 4-8

man pages, 4-15

printing help topics, 4-18

searching (keyword index), 4-10

server, 4-2

subpanel, 4-3
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topic hierarchy, 4-8

opening

application window, 3-3

directory in File Manager, 5-13

document from File Manager, 6-8

document in Text Editor, 6-7

existing document in Text Editor,

6-7

�le in File Manager, 5-13

�le in Text Editor, 6-5, 6-7

Help Manager, 4-13

new document in Text Editor, 6-5

object in File Manager, 5-13

terminal window in current

directory, 5-21

Trash Can, 5-22

window, 3-3

options

elm mailer, 7-26

order

changing File Manager sort, 5-30

overlapping windows, 3-7

other (for �le permissions), 5-8

overlapping windows, changing order

of, 3-7

owner of �le, 5-8

changing in File Manager, 5-19

Owner's Guide, 1-23

P

packaging �les for mailing, 7-24

pages, displaying man, 4-15

.. (parent directory), 5-6, 5-31

password

changing, 1-21

guidelines, 1-17, 1-21

root, 1-4

superuser, 1-4

pasting

text in Text Editor, 6-15

text into windows, 3-23

path

absolute, 5-5

de�ned, 5-5

relative, 5-6

peripherals

installing, 1-23

permissions

changing in File Manager, 5-20

example of changing, 5-8

execute, 5-8

read, 5-8

write, 5-8

pointer, mouse, 1-9

dragging with, 1-9

moving, 1-9

shapes, 1-8

popup menu, 5-4

power

turning o�, 1-20

turning on, 1-5, 1-7

preloaded software, 1-3

printing

document in Text Editor, 6-24

help topics, 4-18

problems

System Administration Tasks, 1-24
properties, changing

directory, 5-19, 5-20

�le, 5-19, 5-20

object, 5-19, 5-20

protecting

directories in File Manager, 5-20

�les in File Manager, 5-20

push button, 3-26

putting

�le or directory on Desktop, 5-25

object on Desktop, 5-25

window in multiple workspaces,

3-7
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Q

quitting

elm, 7-23
Text Editor, 6-11

R

radio button, selecting, 3-27

reading mail, 7-7

read permission, 5-8

reference pages, 4-15

relative path name, 5-6

remote

host, 3-36

system, 3-36

terminal window, 3-36

removing

�le or directory from Desktop,

5-27

object from Desktop, 5-27

renaming

directory in File Manager, 5-12

�le in File Manager, 5-12

object in File Manager, 5-12

workspace, 3-19

replacing

text in Text Editor, 6-16, 6-18

replying to messages, elm mailer,

7-16

requesting help, 4-6

resize function, 3-6

resizing

window, 3-6

re-sorting

�les and directories, 5-30

objects, 5-30

restoring

iconi�ed window, 3-5

items in Trash Can, 5-23

text in Text Editor, 6-14

�Return�, 3-2
root

password, 1-4

user, 1-4

rules

�le names, 6-10

password, 1-17, 1-21

runtime HP-UX, 1-6

S

SAM, 1-2

saving

document in Text Editor, 6-9

File Manager current preferences

as default, 5-31

home session, 2-16

mail to a �le, 7-20

screen

locking, 2-19

scrolling

contents of window, 3-25

documents in Text Editor, 6-12

searching

online help (keyword index), 4-10

text in Text Editor, 6-17

search permission, 5-8

security

�le ownership, 5-8

�le permissions, 5-8

locking the display, 2-19

selecting, 1-9

directory, 5-10

�le, 5-10

icon, 5-10

multiple directories, 5-11

multiple �les, 5-11

multiple icons, 5-11

multiple objects, 5-11

object, 5-10

text in Text Editor, 6-14

toggle or radio button, 3-27

self-tests, 1-5, 1-7

sending mail, 7-9, 7-11
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server

online help, 4-2

session

canceling, 1-18

ending, 1-18

home, 2-16

in non-English languages, 2-14

starting HP VUE, 1-11

types other than Regular, 2-13

set_parms program, 1-22

setting

host name, 1-22

IP address, 1-22

system parameters, 1-22

time zone, 1-22

shar command, 7-24

ShutdownSystem action, 1-20

shutting down your workstation

in HP VUE, 1-20

Soft Powerdown feature, 1-20

using ShutdownSystem action,

1-20

skills, basic

�le management, 5-10

window management, 3-1

sliders, using, 3-28

Soft Powerdown feature, 1-20

software, installing, 1-3

sort order, changing File Manager,

5-30

special characters, using in Text

Editor, 6-22

spelling

correcting in Text Editor, 6-19

standard jump hyperlink, 4-8

starting

choosing procedure, 1-2

elm mailer, 7-2

failsafe session, 2-13

Help Manager, 4-13

home session at login, 2-17

HP VUE Lite session, 2-13

HP VUE session, 1-11

No Windows mode session, 2-13

terminal window, 3-31

terminal window in HP VUE Lite,

3-35

Text Editor, 6-3

workstation after �rst time, 1-7

workstation for �rst time, 1-2

startup

choosing procedure, 1-2

set_parms program, 1-22

stopping

elm, 7-23
Text Editor, 6-11

subdirectory

navigating in File Manager, 5-21

subnetwork mask, 1-4

subpanel

choosing control from, 3-16

displaying, 3-16

superuser, 1-4

logging in, 1-12

password, 1-4

symbolic link

creating in File Manager, 5-18

creating in HP VUE Lite, 5-19

syntax

mail addresses, 7-12

system

aliases, elm mailer, 7-13

name, 1-3

parameters, 1-22

shutdown, 1-20

System Administration Manager, 1-2

SystemAdministration Tasksmanual,
1-24

system administrator, 1-2

what to do if none available, 1-2
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T

tasks

changing your password, 1-21

correcting misspelled words, 6-19

creating new user accounts, 1-14

cutting and pasting text, 3-23

editing text in Text Editor, 6-14

�nding workstation information,

1-23

getting help, 4-2

installing your workstation, 1-2

learning how to use the mouse,

1-8

locking the display, 2-19

logging in, 1-11

logging in to HP VUE Lite, 2-13

logging in with a non-English

language, 2-13

logging out, 1-18

moving windows, 3-5

printing from Text Editor, 6-24

reading electronic mail, 7-7

replying to electronic mail, 7-16

resizing windows, 3-6

saving electronic mail, 7-20

sending electronic mail, 7-9, 7-11

shutting down your workstation,

1-20

starting your workstation, 1-2

suspending HP VUE, 2-14

using commands, 3-29

using electronic mail, 7-2

using Front Panel to start

applications, 2-12

using menus, 3-10

using windows, 3-2

Terminal

control, 3-31

subpanel, 3-36

terminal emulator, 3-29

terminal window, 3-29

in failsafe session, 2-14

in HP VUE Lite, 3-35

opening in current directory, 5-21

starting from command line, 3-32

using, 3-34

text

annotation, 5-3

cutting and pasting in Text Editor,

6-15

cutting and pasting in windows,

3-23

editing in �eld, 3-22

editing in Text Editor, 6-1, 6-14

editors, 6-14

entering into empty �eld, 3-22

Text Editor

checking and correcting spelling,

6-19

clearing text, 6-16

closing, 6-11

copying text, 6-15

cutting and pasting text, 6-15

deleting text, 6-15

editing text, 6-14

entering text, 6-5

exiting, 6-11

�nding or searching for text, 6-17

formatting document, 6-23

including or inserting �le, 6-20

justi�cation, 6-23

margins, 6-23

moving cursor in document, 6-12

moving text, 6-15

opening document, 6-7

printing document, 6-24

replacing text, 6-16, 6-18

saving changes, 6-9

saving document, 6-9

scrolling a document, 6-12

selecting text, 6-14

special characters, 6-22
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starting, 6-3

typing text, 6-5

undoing edit, 6-14

unselecting text, 6-14

using, 6-1

word wrapping, 6-6

text editors, 6-2

text patterns

�nding in Text Editor, 6-17

timeout, 2-19

time zone, 1-4

toggle button, selecting, 3-27

topic hierarchy, online help, 4-8

Trash Can

emptying, 5-23

opening, 5-22

putting directory in, 5-22

putting �le in, 5-22

putting object in, 5-22

restoring object from, 5-23

using, 5-22

Trash control, 5-22

troubleshooting

System Administration Tasks, 1-24
turning o� your workstation, 1-20

Soft Powerdown feature, 1-20

turning on your workstation, 1-5,

1-7

typing

in Text Editor, 6-5

typographic conventions, vi

U

undoing edit in Text Editor, 6-14

unlocking display, 2-19

unselecting text in Text Editor, 6-14

updating

Installing HP-UX, 1-23
urgent message, sending with elm,

7-10

user account

creating in HP VUE, 1-14

user aliases, elm mailer, 7-13

users

group, 5-8

other, 5-8

owner, 5-8

user's guides available, 1-23

using

controls in application windows,

3-21

Desktop, 5-25

Front Panel, 2-12, 3-15

home session, 2-16

menus, 3-10

mouse, 1-8

No Windows mode, 2-14

sliders, 3-28

terminal window, 3-34

Trash Can, 5-22

windows, 3-2

V

views, controlling File Manager, 5-30

view style, changing File Manager,

5-31

vuepad command, 6-4

W

Welcome window, 1-13

wildcards, matching, 5-28

window

active, 3-2

basic skills, 3-1

changing order of overlapping

windows, 3-7

closing, 3-3

cutting and pasting text in, 3-23

displaying, 3-3

focus, 3-2

frame, 3-2

iconifying, 3-4
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moving, 3-5

opening, 3-3

putting in multiple workspaces,

3-7

raising, 3-7

resizing, 3-6

restoring, 3-5

scrolling contents of, 3-25

terminal, 3-29

turning into icon, 3-4

using controls in application, 3-21

Welcome, 1-13

window icon, moving, 3-5

window menu, 3-12, 3-13

button, 3-33

word wrap, turning on and o�, 6-6

workspace

displaying another, 3-18

putting window in multiple

workspaces, 3-7

renaming, 3-19

using keys to move around in, 3-9

Workspace menu, 3-13

logout command, 1-18

workstation

choosing startup procedure, 1-2

information about, 1-23

installing hardware, 1-2

shutting down, 1-20

starting after �rst time, 1-7

starting for �rst time, 1-2, 1-5

write permission, 5-8

X

X server, stopping temporarily, 2-14

xterm, 3-30
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